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Introduction

AlphaLAN version 6.0 comes with various new features, offering many major
additions to AlphaLAN version 5.0. It includes a new set of programs that offer new
terminal emulations and file transfer functions through file exchange protocols, e.g.,
XMODEM, YMODEM, ZMODEM, KERMIT and ASCII, both for DOS and Windows.

These release notes describe the changes between version 5.0 and the current
release. The following table gives the dates and version numbers for the previous
three major releases of this software.

Version Date

5.0
4.3
4.2

Oct. 10, 1993
April 9, 1993

May 27, 1992

1. New Features

For Windows Connectivity:

1. Modem file transfer

AlphaLAN supports file transfer using standard file transfer protocols, such as ASCII,
XMODEM, YMODEM, ZMODEM and KERMIT. Variations of XMODEM protocol, i.e.
XMODEM-1k and of YMODEM protocol, i.e. YMODEM-G are also supported. In all
the protocols, CRC checks (8 bit, 16bit or 32bit, whichever applicable) are also
allowed.

2. Terminal Emulation

AlphaLAN provides two new emulations — AM62C and PCFM. AM62C allows you to
use AM62A emulation (field attributes) with mode colors. The new Terminal Driver,
called PCFM is the "native" AlphaLAN emulation with field attributes and mode
colors. Improved ANSI emulation now supports 8 bit graphics characters and
ESPRIT III emulation provides support for 4 pages. The Wyse50 emulation provides
bi-directional port support.

3. Fast Field Emulation

There has been a significant improvement in the speed of field terminal emulations.
With AlphaLAN 6.0 for Windows, a new logic for emulating field terminal is
incorporated. This resulted in performance improvement of about 50% for field
emulations.
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4. Tool Bar

Tool bars are provided for quick access to commonly used commands like open and
save configuration, clipboard operations, dial, hang-up, etc.. You can add, delete,
move or regroup buttons on the tool bar as per your requirements.

5. Improved User Definable Keys

You can assign your own labels and multiple character sequences to 64 mouse
selectable keys, which are not associated with any key on your key-board. You can
even select these keys to execute any local Windows program.

6. PicLan Protocol support

AlphaLAN 6.0 also supports PicLan protocol for connecting to a host.

7. Selectable foreground color on AM70/WYCOL emulation

On color field terminals(such as AM70, ESPRIT III etc.), whenever you set the
background color the foreground color always switches to Black, as field terminals
can hold only one attribute at a time. With AlphaLAN/FW 6.0 you can define the
foreground color to be a color other than black.

8. Destination file name in Native file transfer (CPC/CALF)

You can now specify the destination file name(s) during file transfers over an
AlphaMicro host (using CPC.LIT or CALF.LIT).

9. Finger

The “Finger” application allows you to query any host system that is on the network
for information about the users currently logged on to the host. It allows you to get
more detailed information about a particular user or all the users.

10. New HASH program

The new hash program provides an improved user interface and better file handling.
Also, you can invoke this utility for calculating hashes from the File Manager’s menu
bar. An item called “Hash” is now available in the File Manager’s Menu Bar.

11. A whole new keyboard remapper

A new user interface is provided for customizing the keyboard according to your
need. A dialog box would appear with the layout of an extended 101 key PC
keyboard. This feature allows you to easily change key settings and save them in a
file. Multiple sets of settings can be defined, saved in different files and then loaded.
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12. Auto dial on startup

You can select an entry in the Phone Book to be “Auto Dialed”. If you check on the
“Auto dial on startup”  option in the Phone Book dialog box, the selected number is
dialed automatically when you start AlphaLAN.

13. AlphaLAN Drag and Drop FTP

AlphaLAN FTP provides a drag and drop user interface to the ARPANET standard
File Transfer Protocol (FTP). It allows users to log onto remote systems, transfer files
/ directories to and from a remote system. Additionally, it allows some basic file
management functions like looking into the contents of remote directories, creating
and removing directories etc..

14. Graph for Windows

Graph for Windows is an optional feature for AlphaLAN/FW 6.0. Using this feature
and Graph functions of AMIGOS, you can display various graphs and charts in
Windows environment. It provides a high level of graphing and charting functions.
This feature is available only if you purchase PEG option with AlphaLAN.

15. Status line

Shows help for Menu items, toolbar icons and displays status information for various
AlphaLAN functions.

16. Host program control for loading user defined keys and
screens

You can now load the user defined keys from your AMOS program by using special
Escape codes. Similarly you can ask AlphaLAN to display previously captured
screens from your host program control.

17. Other Miscellaneous Improvements/Features

Various other features that have been added in this release are as follows:

l Shut off printer option through configuration file.

l Editable save/restore pages.

l Convert UA fonts to ANSI fonts for compatibility.

l Improved installation program with new user interface, improved destination filename
handling, etc..

l Improved modem command handling.

l Improved menu handling.

l Improved Native file transfer handling. It is more robust, now.

l Added Confirm if loading a new configuration file.
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l Changed column selection from “right” mouse button to “Alt left” mouse button.

l Added a warning if a new AlphaLAN session is invoked on the same serial port
where a previous one is already running.

l Launch AlphaLAN in minimized state if it is specified in the properties of the
AlphaLAN icon.

l Setting directories: The current working directory, and file transfer directories for
upload/dnload can all be selected by the user in AlphaLAN 6.0

l Menu locking to prevent others from changing your setup.

l Improved TELNET/Rlogin protocol handling.

l Improved TCP/IP connect dialog box handling to allow you to type in the host
address. If there is no “hosts” file or no list of host address/names in that file in your
PC, AlphaLAN would show a connect box and allow you to type in the host
name/address.

l Added 42/49 row support in WYCOL emulation.

l Larger than 32 mega bytes file transfer support in native file transfer with an AMOS
host.

l Support for taking inputs from a secondary port. If a secondary port is defined in the
configuration file, AlphaLAN can take inputs from this port and relay it to the host.

l Replay host log file.

l On line help for dialog boxes.

l Full screen Window.

l Modified terminal emulation
—  Erase to end-of-line,
—  Split screen/ cursor positioning,
—  Box fill with attribute,
—  Top status line.

l Bi-directional support in WYSE50 emulation (Windows only).

l 3-D controls in dialog boxes.

l AlphaNET 2.4 support has been added.

For DOS Connectivity:

18. Modem file transfer

AlphaLAN 6.0 supports file transfer over modems using standard file transfer
protocols. The protocols supported are ASCII, XMODEM, YMODEM, ZMODEM and
KERMIT. Variations like XMODEM-1k and YMODEM-G are also supported.

19. Selectable foreground color on AM70/WYCOL emulation
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On color field terminals(such as AM70, ESPRIT III etc.), whenever you set the
background color the foreground color always switches to Black, as field terminals
can hold only one attribute at a time. With AlphaLAN/FW 6.0 you can define the
foreground color to be a color other than black.

20. New installation program

With this new installation program, ALINSTALL, you can select all the basic
communication parameters and set the terminal type you want to emulate. As a
result, you will need to execute the setup program, SETPC, only if you need to
change other settings.

21. Modified setup program, SETPC

The setup program, SETPC, allows you to change/modify modem dialing command
and modem initialization string. If you change any parameter and then select "Quit"
from the main menu, SETPC will ask for confirmation. AlphaNET settings interface
has also been improved.

22. Destination file name in Native file transfer (CPC/CALF)

You can now specify the destination file name(s) during file transfers to an
AlphaMicro host (using CPC.LIT or CALF.LIT).

23. Phone Book

AlphaLAN offers you a new feature, namely Phone Book, for maintaining phone
directories through the program - PB.EXE. You can maintain different Phone Book
files. You can also add, edit or delete an entry and directly dial any entry from the
currently selected Phone Book file. Phone Book entries may have different
communication parameters associated with them.

24. Other Miscellaneous Improvements/Features

The new features which have been added are:

l Shut off printer option. If you select the “Disable Printing” under the “Preference” sub-
menu of the “Terminal” menu item as “YES”, then all the printing sequences would
be ignored by AlphaLAN and all the incoming characters/data would be displayed on
the terminal

l 42/49 row support in WYCOL emulation.

l Improved cursor positioning on TCRT calls.

l Improved CTRM program (to connect to an AMOS system over AlphaNET) for better
error and message handling. AlphaNET 2.4 support has been added.

l Improved FRCTRM. It now returns a DOS ERRORLEVEL if there is any error during
NATIVE file transfers (CPC/CALF executed with “/G” option).

l “OPEN” program to open communication has been improved to handle errors and to
retry opening communication.
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l Improved security checking on AMOS system in open communication mode during
breakdown cases, such as sudden power failure, switching off the PC without closing
the communication, etc..

2. Installation instructions

2.1 Before Installing AlphaLAN 6.0

What is AlphaLAN 6.0?

AlphaLAN 6.0 consists of two sets of program, one for DOS and another for
Windows. The windows set of AlphaLAN programs is called AlphaLAN For Windows
or AlphaLAN/FW, henceforth. The DOS set of AlphaLAN programs is called
AlphaLAN for DOS or simply AlphaLAN. Both AlphaLAN for DOS and AlphaLAN
for Windows are combined into one product, AlphaLAN 6.0 . You can "encode"
AlphaLAN 6.0 to run under "DOS only" (like previous versions) or for an "incremental
cost", encode it to run "Both DOS and Windows" programs.

The DOS set of programs provide Print and Disk server functions for both DOS and
Windows users. These programs also provide Terminal Emulation and File Transfers
for DOS users. AlphaLAN program "ORBIT" provides all the above features. The
program "MINOR" provides Print and Disk server functions only. MINOR is used by
Windows users for providing the Print and Disk Server functions, while
AlphaLAN/FW program 'WINORBIT' performs the Terminal Emulation and File
Transfer functions.

Minimum System Requirements

AMOS AlphaNET DOS Windows
AlphaLAN
(DOS)
Serial: AMOS/L 1.2A or

AMOS/32 1.0
N/A 2.0 N/A

AlphaNET
Type 1 AMOS/L 1.3D or

AMOS/32 1.0D
2.1 3.3 N/A

Type 2 AMOS 2.2 2.2A 3.3 N/A

AlphaLAN/FW
Serial AMOS/L 1.2A N/A 3.3 3.1

AlphaNET
Type 1 AMOS/L 1.3D or

AMOS/32 1.0D
2.1 3.3 3.1

Type 2 AMOS 2.2 2.2A 3.3 3.1

AlphaLAN/FW
with Insight/am
Serial AMOS 1.3 N/A 3.3 3.1

AlphaNET AMOS 1.4 or 2.2 2.2A 3.3 3.1
For AlphaLAN/FW , you will need a PC running Windows 3.1 in Enhanced mode. We recommend 80386SX or
better, 4MB RAM,  VGA monitor, display card and a mouse.
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Can I mix both DOS and Windows workstations on the same Alpha Micro?

Yes! You can mix the two, if you have configured AlphaLAN 6.0 to run with both DOS
and Windows. For those users who do not wish to use Windows at all, AlphaLAN can
also be configured to run with DOS only.

Differences Between AlphaLAN for DOS and AlphaLAN/FW

While AlphaLAN/FW is a full feature product  offering most of the functions available
in earlier versions of AlphaLAN, there are slight differences between the two
products, due to the inherent nature of the underlying operating environment and the
product design. While the following table lists most of these differences, you may find
some other subtle differences.

AlphaLAN (DOS) AlphaLAN/FW
Terminal Emulations

AM62A
AM62C
AM65
AM70
ANSI
ESPRIT III
PC/PCFD
PCFM
TVI925
VT100
WYSE50
WYSE350
WYSE370
WYCOL

YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES

YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
NO
YES
YES

TCP/IP Support

PC/TCP Kernel from FTP Inc.

Other Kernels supporting
Windows Socket API

Rlogin (for UNIX hosts only)

TELNET

File Transfers
(Rlogin on UNIX hosts only)

Print/Disk server on TCP/IP

FTP

FINGER

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

YES

YES

YES

YES

YES

N/A

YES

YES
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AlphaLAN (DOS) AlphaLAN/FW

TERMINAL EMULATION
FEATURES

Color Palette through (TCRT 157)

Color Palette through menu

Select Primary/Secondary
Printer (TCRT 189/190)

Top Status Line (TCRT 63)

Non Blinking Cursor
(TCRT 121/123)

YES

NO

YES

NO

NO

NO

YES

NO

YES

YES

MISCELLANEOUS

Multiple Sessions on Ethernet

PEG - GRAPH.SYS support

PEG - Full AMIGOS support

FRCDOS and FRCTRM programs

FORCPC and KILLPC programs

Screen Saver

NO

YES

YES

YES

YES

YES

YES

YES

NO

NO

NO

NO**

** Available through Windows Control Panel

2.1.1 AlphaLAN 6.0 and Windows for Workgroup

AlphaLAN 6.0 is compatible with Windows for Workgroup. You will need to use the
new Clarkson compatible AlphaNET packet driver, called ETHERNDV, if you
connect your PCs to AlphaMicro using ethernet. EtherNDV requires a faster 386 or a
486 system in order to work properly.

When using AlphaLAN's print server function, you will need to use AlphaLAN's Minor
program on each Windows Workstation. You will not be able to redirect printing to
AlphaMicro printers from a non-AlphaLAN Workstation.

If you want to use AlphaLAN 6.0 over AlphaNET on an existing Windows for
Workgroups network see Appendix A  for installation instructions of AlphaNET on
Windows for Workgroups.
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2.1.2 Multiple Concurrent Sessions

Does AlphaLAN/FW support multiple sessions?

Yes, it does (but read on). This means that you have multiple connections to the same
host, or multiple connections to multiple hosts, or connections to Alpha Micro hosts
while connecting to other hosts, such as bulletin boards. But you do need to have the
right configuration.

Using network protocols like AlphaNET and TCP/IP over Ethernet, AlphaLAN/FW can
support multiple sessions to multiple hosts, limited only by the memory and
performance of the PC and, of course, the amount of room on the PC screen. You
also need to have enough resources (jobs, VTSER memory, AMOS port licenses,
etc.) on the AMOS host.  Remember that AlphaBASE, MetropoliS and FLiP users
may not be able to use AlphaNET/Ethernet connections.

AlphaLAN/FW provides multiple sessions support on AlphaNET by using a program
called ANDVR. It also supports any TCP/IP kernel that follows Windows Socket API.
Multiple sessions support over TCP/IP is provided by most TCP/IP kernel.

A serial connection can only support a single session to a single host, but you can
have multiple sessions, but only one over each cable. AlphaLAN/FW supports COM1:
through COM8: at the standard PC interrupt levels and memory addresses.
Therefore, you can have multiple sessions by using multiple cables connected to
different ports on your host. And, yes, you can mix a single Ethernet connection with
one or more serial connections, if you know what you are doing.

With multiple serial connections , you need to be aware of Window's performance
limitations. It is your responsibility to ensure that your PC can handle multiple
connections.

How does the user choose which session to start up?

You can set up one Windows icon to drive each connection, or each choice of
connection parameters. Therefore, the user just needs to click on the appropriate
icon, and he or she is connected to the appropriate system using the desired
parameters.

So, are there multiple configurations I can set up?

Yes. That's the idea behind the multiple icons. Each icon refers to a setup that's
stored in its own unique configuration file on the PC. The setup stores not only the
starting sequence to fire off at the host on establishing connection, but also the
configuration that the user last saved during the last time that icon was used. That is,
the "user preferences" such as font selection and size, port used, baud rate used,
function key template visibility, user defined key definitions, etc. are also stored
behind the icon.

Thus, the system can be configured in a myriad of ways. The fact that you are
running on a host system can be hidden from the PC user if you take the time to set
up "things" on both the host and the PC side to achieve the seamless integration
that's possible. Look in the end-user documentation for more details.

How many workstations can I connect to one AMOS host?

As with any type of terminal connection, the number of workstations that can be
effectively supported depends on many factors, including the performance level of
the host system hardware, the amount of activity on each connection, and the
particular application in use. Since we're all used to configuring systems taking this
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into account, perhaps it's best to characterize the number of connections by
comparing them to traditional serial connections.

When connecting a workstation via serial ports, the loading on the system should be
little different than when using a traditional character terminal. When connecting via a
network connection, you must take into account the type of AlphaNET connection in
use. Using Type 1 connections limits the number of workstation connections you can
sustain to around ten active workstations. If the workstations are not busy, you may
be able to attach more, but generally Type 1 connections should be treated as high
overhead connections.

When using Type 2 connections you can treat the workstations as if they were
connected via serial lines; the overhead of the Type 2 network connection is actually
slightly lower than with traditional character terminals connected via serial ports.

So, are AMOS 1.x systems more limited than AMOS 2.x systems?

Yes, they are. Type 2 connections, which can only be established with systems
running AMOS 2.2 or later, were created specifically to reduce the overhead of the
older Type 1 connections. For those systems that need large numbers of network
virtual terminal connections, AMOS 2.2 offers significant performance advantages in
addition to many other enhancements.

You can start up multiple copies of AlphaLAN/FW and get connected to different
hosts over RS232 or network protocols. Multiple copies of AlphaLAN/FW over
RS232 can function if you have more than one COM port available on your PC.
AlphaNET users will require as many copies of ANDVR's loaded in DOS memory
before loading Windows as the required number of sessions.

F Note:  AlphaLAN will count each session on RS232 connection as a separate
node.  However, all AlphaNET sessions from a single PC will be considered as
one single node of AlphaLAN. However, the actual number of sessions may be
restricted by the number of AMOS user licenses for a given host, as AMOS
counts each of these sessions as a separate user license.

2.2 If you are upgrading an existing installation

Please go through the following important upgrade information before installing your
upgrade.

2.2.1 Important Installation information about version 6.0

� AlphaLAN 6.0 is a major new upgrade and has many substantial changes from
previous versions. Therefore, PC side programs of AlphaLAN 6.0 may not work with
Alpha side programs of earlier versions of AlphaLAN and vice-versa. You must
install Alpha side software of AlphaLAN 6.0 first, before updating PCs.

� If you are upgrading from AlphaLAN version prior to 5.0, a new program ANSER.LIT
will need to be added to your system INI file on Alpha Micro. Therefore, you must
install Alpha side software of AlphaLAN 6.0 first , before installing PC side software.
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Please note that AlphaLAN 6.0 PC side software will not communicate over
AlphaNET, unless you load the new Alpha side programs on your Alpha Micro
and modify the INI file to include the ANSER.LIT installation.

• AlphaLAN 6.0 for Windows has a whole new keyboard remapper which is not
compatible to the one in 5.0. If you had remapped your PC keyboard using
AlphaLAN 5.0 keyboard remapping function, this information would be lost and you
will need to reenter this information in 6.0. This incompatibility applies to AlphaLAN
for Windows, only.

2.2.2 Installing the 6.0 update on Alpha

Save your current installed files on the Alpha system.

If your current update has been supplied to you on a VCR / Streamer tape, you can
go to the section "Installing Alpha side software from VCR / Streamer tape" . If
your update is supplied on a DOS diskette, then the Alpha side software needs to be
transferred from the floppy diskette to your Alpha system using the previous version
of AlphaLAN.

Installing Alpha side software from PC diskette

Do not update the PC side software first as it may prevent you from transferring the
Alpha side files. Insert AlphaLAN 6.0 "Alpha" disk in drive A. Make sure you are on a
PC that is connected to the Alpha system using AlphaLAN software. Press the hot
key to go to AMOS prompt. Create a new temporary account on Alpha. If you use an
existing account, make sure that there are no existing files in that account. Now,
enter:

CALF   A:\ALPHA\*.* <CR>

at the AMOS prompt. This will transfer all the Alpha side files to the Alpha account
you are logged in.

After all the files are successfully transferred, log to OPR: account. From this
account, invoke ALUPD command file to copy various AlphaLAN files from the
temporary account to the respective accounts on DSK0:. The syntax for invoking
ALUPD command is:
DO  devn:[p,pn]ALUPD  devn:[p,pn] <CR>

For example, if your temporary account (having AlphaLAN update files) is
DSK1:[25,10], you should give the following command:

DO  DSK1:[25,10]ALUPD   DSK1:[25,10] <CR>

Next, give the command VERIFY  ALFLAN from the OPR: account. This will verify
that your AlphaLAN update has been copied correctly. Please go to the section
named "PIC encoding your new software".

Loading Alpha side software from VCR / Streamer tape

If your software has been supplied to you on VCR / Streamer tape, you will need to
restore all the files from it to the Alpha disk by giving the following command from
OPR: account:

VCRRES/T DSK0:[]=ALL:[] <CR> ; for VCR
MTURES DSK0:[]=ALL:[] <CR> ; for Streamer
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Next, give the command VERIFY ALFLAN from OPR: account. This will verify that
your AlphaLAN update has been copied correctly.

PIC encoding your new software

To PIC encode your software run IPLAN program from OPR: account. You will need
a new PIC to install the new software. Re-encode your Alpha side software using this
PIC.

Product: AlphaLAN ____ o "DOS Only"

SSD: o "Both DOS and Windows"

ID:

PIC for IPLAN (for ___ PCs) :

PIC for IPEG  (for ___ PCs) :

F You will need a PIC code for "Both DOS and Windows" to use the AlphaLAN
programs for Windows.

Modifying the System INI file to include ANSER

If you are using AlphaLAN to communicate via AlphaNET protocol over network
connections, you may need to modify your System INI file to include ANSER (in case
you were using AlphaLAN version prior to version 5.0). This is required even if you
do not plan to use the new AlphaLAN programs for Windows. You should not  include
ANSER and skip this part of the installation, if you do not have AlphaNET installed on
your AlphaMicro.

Log into DSK0:[1,4] and make a copy of your system INI file. A sample command for
doing so would be :

COPY TEST.INI=AMOSL.INI

or

COPY TEST.INI=AMOS32.INI

After creating TEST.INI, edit it using AlphaVUE and make the changes as described
below.

Increase the number of AMOS jobs by incrementing the number in the JOBS
statement. Add ANSER in the JOBALC statement of your INI file. Add a TRMDEF
statement for ANSER in your INI file. A typical TRMDEF statement would be:

TRMDEF ANSER, PSEUDO, NULL, 100,100,100

Insert the following line before the last SYSTEM command,
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SYSTEM ANSER/N

Now you will need to attach ANSER.LIT to the ANSER job. Add the following lines in
the section of the INI file where you have other ATTACH statements. Please make
sure that NETSER is attached and running before  attaching ANSER to ANSER
job.

ATTACH ANSER, ANSER
KILL  ANSER
FORCE ANSER
MEMORY 10K
LOG DEMO
ANSER

WAIT ANSER

Reboot your Alpha Micro with this INI file. After the system boots up properly, run
STAT from your console. The status of the ANSER program should be  "Rn Ms ". If
everything is OK, you can copy the TEST.INI file as your system INI file. This
completes the installation of the update on your Alpha system.

Refer to section 2.4, for installation of the update on your PC.

2.3 Installing AlphaLAN for the first time

Follow these instructions please:

Ø Files from the VCR Tape have to be copied in  the  respective accounts on DSK0: on
the Alpha system. To restore files from the VCR Tape, give the following command
from the OPR: account:

VCRRES/T DSK0:[ ]=ALL:[ ] <CR>

After restoring the VCR Tape, give the command VERIFY ALFLAN to verify all
AlphaLAN files.

Ø After this, you have to install the cable, PIC encode the Alpha Side software using
the  IPLAN program and modify the system INI file. If you want to use AlphaNET,
you must also install ANSER.LIT as per instructions given in the previous
section under the heading Modifying the system INI file . If you are using
AlphaLAN 6.0 Windows program for terminal emulation then you also need to
change the terminal driver for your job to PCI or PCFDI (these drivers are
inSight/am compatible).  For detailed instructions on other modifications, please
refer to Chapter 2 of the AlphaLAN Installation Manual. If you are using AlphaLAN's
Terminal Emulation and File Transfer Functions only, skip the next step.

Ø The files LOGNAM.PC[1,4], DEVNAM.PC[1,4] and JOBNAM.PC[1,4] should be
created according to need. The files LOGNAM.PC and DEVNAM.PC define six
character names for different accounts on Alpha, which are used by PC users as the
Login names for logging in their accounts on the Alpha (through the DOS side
command of AlphaLAN - OPEN), and for creating the DOS remote devices (on the
Alpha disk) in various accounts, respectively. These files can also be created or
modified by  using AlphaLAN commands, LOGNAM and DEVNAM (from the OPR:
account). Sample files (LOGNAM.SMP and DEVNAM.SMP) are also supplied and
may be renamed (to LOGNAM.PC and DEVNAM.PC) and then modified as per your
needs.
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Ø The file JOBNAM.PC in DSK0:[1,4], defines four character names for identifying
different PCs and terminals connected to various jobs attached to the Alpha system.
The names defined in JOBNAM.PC are used by AlphaLAN commands (like
SENDPC, FORCPC, etc.) to send messages to or force and kill commands on
various PCs or terminals. These names need to be defined only if you are going to
use the above commands. Also note that you can use the AMOS job names directly,
without having to define them in this file. This file may be modified using VUE  from
SYS: account. Care should be taken to start the job names immediately following the
":" (without leaving any blanks) and to retain the last character in the file, i.e. the
DOT.

The instructions for PIC encoding (given in the Manual) should be followed carefully
for configuring the AlphaLAN software to run on your Alpha system.

2.4 Installation of AlphaLAN software on PC

AlphaLAN software on PC includes two set of programs - Windows programs  and
DOS programs. If you are installing AlphaLAN EL, you can decide whether you want
to use it under DOS or Windows, or both, and then install the programs accordingly.
If you are installing AlphaLAN EC or EP then you must install the DOS programs in
addition to the optional Windows programs.

AlphaLAN comes with two install programs, the ALINSTAL program  and a new
Windows program INSTALL. If you want to install only the DOS programs of
AlphaLAN 6.0 then refer to section "Installing AlphaLAN 6.0 from DOS ". If you
wish to install both DOS and Windows programs then you can use INSTALL
program. In this case, please refer to section on "Installing AlphaLAN 6.0 from
Windows ".

Important Note for users updating from a version of AlphaLAN prior to 5.0

� If you are an AlphaLAN EL user and use Windows, you may wish to delete the "old"
ORBIT.COM program from your PC's hard disk (do not forget to take the backup of
the old software on a floppy). You can also remove the ORBIT command from the
AUTOEXEC.BAT file, if any.

� ORBIT.COM/MINOR.COM  should be deleted and the new ORBIT.EXE/MINOR.EXE
files should be used. Installation program will delete these .COM files, if found in the
installation directory.

Loading AlphaNET Drivers

Before we proceed with the installation, we would like to talk about setting up your
PC with AlphaNET drivers, in case you are using Ethernet connection. You should
be using the Clarkson AlphaNET driver ETHERNDV.EXE (and not the old WD.EXE
driver).

The following diagram explains AlphaLAN/AlphaNET configuration under Clarkson
packet drivers.
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Clarkson Driver with its parameters
( e.g. WD8003E  0x61 0x05 0x280 0xD000)

|
|

ETHERNDV <int. no.>("int no." is the interrupt with which ETHERNDV
| communicates with ORBIT, ANDVR. Default is

0x5C)
|

ORBIT, ANDVR /A=<ETHERNDV int no.> /I=<WINORBIT interface interrupt>
|
| (Default ETHERNDV interrupt is 5C if /A option

is not specified and WinORBIT interrupt is 60(H)
if /I option is not specified)

|
WINORBIT.EXE (Communicates with ANDVR)

The following set of commands load WD8003E with its interface to ETHERNDV set
at 0x61, ETHERNDV with its interface to ORBIT/MINOR or ANDVR set at 0x62 and
ANDVR with its interface to WINORBIT set at 0x60

WD8003E 0x61 0x05 0x280 0xD000
ETHERNDV 0x62
ANDVR /A=62

F Please ensure that the interrupt numbers specified in WD8003E and
ETHERNDV do not have the same value.

2.4.1 Installing AlphaLAN 6.0 from DOS

Please go to section 2.4.2 directly, if you are installing AlphaLAN for Windows. The
Windows installation program will install AlphaLAN for both DOS and Windows.

To begin installing AlphaLAN 6.0 DOS programs only, enter the following commands
at the DOS prompt, with AlphaLAN 6.0 Disk# 1 in drive A.

A: <CR>

ALINSTAL <CR>

The ALINSTAL program will ask you about host type and the AlphaLAN product (EL,
EC or EP) that you are installing. Enter this information from the software license
card supplied with the software. Next, it will ask you about the mode of
communication that you shall be using. It then copies the files from AlphaLAN disk to
the specified directory. Next, it will ask you to specify emulation and connection
parameters. ALINSTAL allows you to set up the environment variable (ORB). If you
set this variable, the DOS version of AlphaLAN  will load its configuration file from the
specified directory.  For EC+EP users ALINSTAL now prompts for a user name,
which is the user name under which you are logged into the AlphaMicro system. It
can also add a PATH statement to the existing AUTOEXEC.BAT file so that the
AlphaLAN programs can be loaded even if your current directory is not the AlphaLAN
directory.

If you had selected the protocol as AlphaNET, you should also specify the correct
AlphaNET interrupt number  from the SETPC program. SETPC program can also
define the hosts on your network if you are using AlphaNET protocol. After you have
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finished configuring AlphaLAN, you can save the settings from the "File" menu and
exit using the "Quit" menu of SETPC program.

The ALINSTAL program can also install AlphaNET software on your PC from the
AlphaNET diskette supplied by Alpha Micro. AlphaLAN 6.0 supports the new
AlphaNET PC software, called AlphaNET/PC 3.0. The drivers included with
AlphaNET/PC 3.0 are recommended when you need to run multiple protocols on
your PC workstation. For details, refer to "Using AlphaNET drivers" described earlier
in this section.

Notes for AlphaLAN 6.0 RS232 installations:

The 'ALINSTAL' program generates the following BAT files during the installation
process for RS232 installations:

GOALAN.BAT: This file can be used to start up DOS version of AlphaLAN 6.0.

STOPALAN.BAT: This file is used to stop the DOS version of AlphaLAN 6.0.

The contents of these files vary, depending upon the selections you make during the
installation process. The following sample GOALAN.BAT and STOPALAN.BAT files
show the typical contents of these files for RS-232 installations.

GOALAN.BAT

SET ORB=C:\ALPHALAN ; Set ORB environment variable to installation
; directory

ORBIT
OPEN demo ; For EC+EP users, “demo” is user name on

; the host system

STOPALAN.BAT

ORBIT/D

To start AlphaLAN 6.0 in SERIAL mode, just type 'GOALAN <enter>'. This command
loads the main AlphaLAN program ORBIT.EXE in memory. Now, press the HOT key
"Alt+F10"  to switch to the terminal mode. Pressing "Return" or "Control-C" gives you
the AMOS prompt.

To stop AlphaLAN, press the hot key "Alt+F10" again to  switch to the DOS prompt
and  type 'STOPALAN <enter>' . The STOPALAN command unloads the ORBIT
program from memory.

F If you are using RS232 connection, please select the correct Baud rate, the
terminal type etc. from SETPC program. Refer to "Installation manual" for details.

Notes for AlphaLAN 6.0 AlphaNET installations:

The 'ALINSTAL' program generates the following BAT files during the installation
process for AlphaNET installations:
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GOANET.BAT
GOALAN.BAT
CALAN.BAT
STOPALAN.BAT

The contents of these files vary, depending upon the selections you make during the
installation process. The following sample GOANET.BAT, GOALAN.BAT,
CALAN.BAT and STOPALAN.BAT files show the typical contents of these files for
AlphaNET installations.

GOANET.BAT

This file is created in the AlphaNET installation directory and loads various drivers
required for the proper functioning of AlphaLAN 6.0 over AlphaNET. A sample
GOANET.BAT file is described below:

WD8003E 0x61 0x5 0x280 0xD000 ; The Clarkson packet driver gets
; loaded

ETHERNDV 0x62 ; Load the AlphaNET driver with
; interface set at INT 0x62

CD \ALPHALAN ; Change directory to AlphaLAN
GOALAN ; run GOALAN.BAT file

GOALAN.BAT

This file is used to start up DOS version of AlphaLAN 6.0. A typical GOALAN.BAT
file would contain:

SET ORB=C:\ALPHALAN ; Set ORB environment variable to
;  installation directory

ORBIT /A=62
CALAN ; for AlphaNET users only

CALAN.BAT

This file contains the CTRM command. A typical CALAN.BAT would contain a line
like:

CTRM W=1 G=1 N=1 M=128 T=PC ; Connects your PC to AlphaMicro host.
OPEN demo ; For EC+EP users, “demo” is user name on

; the host system

STOPALAN.BAT

This file is used to stop the DOS version of AlphaLAN 6.0. A typical STOPALAN.BAT
file would contain:

ORBIT /A=62/D

To start AlphaLAN 6.0 over AlphaNET, type 'GOANET <enter>'. This command
loads the packet driver (WD8003E.COM in this case). Then the AlphaNET protocol
driver ETHERNDV. GOANET.BAT shows the packet driver loaded at interrupt
number 0x61 in the above example. ETHERNDV automatically detects this interrupt.
The number specified along with ETHERNDV statement is the interrupt number,
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which AlphaLAN 6.0 uses to communicate with ETHERNDV. This interrupt is 0x62 in
the above example.

After GOANET.BAT loads the AlphaNET drivers, it executes the  'GOALAN.BAT' file
to load ORBIT program and execute CALAN command to connect your PC to your
AlphaMicro host. Now, you can use the HOT key 'ALT+F10' to switch to the terminal
mode.

To stop AlphaLAN, switch back to the DOS command prompt by pressing the hot
key "ALT+F10" and type 'STOPALAN <enter>' . The STOPALAN command
disconnects the AlphaNET session and downloads the ORBIT program from
memory.

F ETHERNDV is the new 'Clarkson packet driver' compatible AlphaNET/PC 3.0
driver. Unlike the old AlphaNET driver, this new driver can be used, if you are
running multiple protocols on your PC. The new driver is also compatible with
Windows for Workgroups.

If you want to use AlphaLAN 6.0 over AlphaNET on an existing Windows for
Workgroups network see Appendix A  for installation instructions of AlphaNET on
Windows for Workgroups.

F If you are using AlphaNET protocol, please use SETPC program to select
AlphaNET under port/protocol. Also select the AlphaNET interrupt number from
SETPC, if you are using the new AlphaNET/ PC 3.0 driver (ETHERNDV.EXE).
Therefore, in the above example, you should use SETPC command and set this
interrupt to "62". Finally select the correct terminal type. Refer to installation
manual for details.

2.4.2 Installing AlphaLAN 6.0 from Windows

The INSTALL program on Windows installs both DOS and  Windows programs of
AlphaLAN 6.0.

To run AlphaLAN 6.0 Windows install program you can give the following command
after inserting AlphaLAN 6.0  DISK #1 in drive A:

WIN A:\INSTALL <CR>

If you were already in Windows go to the Program Manager and choose "Run..."
from its "File" menu. Type "A:\INSTALL" and press the "OK" button.

The INSTALL program will ask you about the product you wish to install. AlphaLAN
6.0 can be installed for any of the following configurations.

inFront : the terminal emulation function only.
AlphaLAN EL : the terminal emulation and file transfer functions.
AlphaLAN EC : AlphaLAN EL + Print server function.
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AlphaLAN EP : AlphaLAN EC + Disk server function.

INSTALL next asks you whether you want to install AlphaNET software. Select “Yes”
if you wish to install AlphaNET software also or if you want to re-configure the
existing .BAT files. INSTALL then displays the “System Settings” box, which asks for
BOOT drive of PC, and whether AUTOEXEC.BAT should be modified. Additionally
EC and EP users should enter the "User Name” which points to the login name on
the host system. After copying DOS and Windows programs, INSTALL program will
load the basic parameters from an existing WINORBIT.INI file (if present) or
SETPC.OVR file (AlphaLAN DOS configuration file), if it exists in the current
installation directory. If none of these are found INSTALL loads the default
parameters. Next it will ask you to setup parameters like protocol, terminal emulation,
etc.. If you selected AlphaNET protocol, it lets you create or modify an existing
ALANHOST file. The install program will create a Program Group and Program Items
in Program Manager. The Program group for AlphaLAN is called "AlphaLAN". The
INSTALL program creates the configuration file "WINORBIT.INI". Finally, you can run
WINORBIT from the Install program itself, if you are using SERIAL RS232
connection. If you select a protocol other than SERIAL, then you must load
appropriate drivers before starting AlphaLAN windows program.

Notes for AlphaLAN 6.0 RS232 installations:

If you have an AlphaLAN EL installation and wish to use AlphaLAN for
Windows, you can go directly into Windows and double click on 'AlphaLAN'
icon in AlphaLAN group to start your terminal window.

The 'INSTALL' program generates the following BAT files during the installation
process for RS232 installation. These files can be used by AlphaLAN EC and
AlphaLAN EP users to start AlphaLAN server program before going into Windows.

GOALAN.BAT To start AlphaLAN server programs,

STOPALAN.BAT To stop AlphaLAN server program

The contents of these files vary, depending upon the selections you make during the
installation process. The following sample of GOALAN.BAT and STOPALAN.BAT
files show the typical contents of these files for an RS232 installation.

GOALAN.BAT

SET ORB=C:\ALPHALAN ; Set ORB environment variable to 
; installation directory

MINOR ; For EC+EP users
OPEN demo ; For EC+EP users, “demo” is user name on

; the host system

STOPALAN.BAT

MINOR/D ; For EC+EP users

If selected during installation, the MINOR command in GOALAN.BAT and
STOPALAN.BAT is replaced  by the ORBIT command. ORBIT will provide
terminal emulation under DOS, but takes much more memory as compared to
MINOR. ORBIT is not required if you are using AlphaLAN for Windows.
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To start AlphaLAN just type 'GOALAN <enter>'. This command  loads the AlphaLAN
program MINOR.EXE in memory, and “opens communication” with the AlphaMicro
host.

Once you have loaded the MINOR program, you can go into Windows and run
WINORBIT program by double clicking the 'AlphaLAN' icon WINORBIT program
from the "AlphaLAN" group. This will start your terminal window by temporarily
closing communication on the same SERIAL port as MINOR is using. Please note
that DISK/PRINT serving will be disabled as long as the terminal window
“WINORBIT” is running. To start Print and Disk server functions again, you should
exit your AMOS application and type DOS at AMOS prompt. Please refer to Chapter
on 'Utilities' in AlphaLAN for Windows 'Users Manual'. You can use the WINALAN
program to select remote printers and “open/close communication” with the
AlphaMicro host. (For details on WINALAN program, please refer to the AlphaLAN
for Windows Users manual).

F Please make sure that you have a "PCI" terminal specified in your system INI file
on the AMOS side. This driver is required for your inSight compatible programs.

To unload MINOR, quit Windows and at the DOS prompt, type 'STOPALAN <enter>'.
The STOPALAN command unloads the MINOR program from memory.

F If you are using RS232 connection, please select the correct Baud rate etc. from
the SETPC program.

Notes for AlphaLAN 6.0 AlphaNET installations:

The 'INSTALL' program generates the following BAT files during the installation
process for AlphaNET installations:

GOANET.BAT
GOALAN.BAT
CALAN.BAT
STOPALAN.BAT

The contents of these files vary, depending upon the selections you make during the
installation process. The following sample GOANET.BAT, GOALAN.BAT,
CALAN.BAT and STOPALAN.BAT files show the typical contents of these files for
AlphaNET installations.

GOANET.BAT

This file is created in the AlphaNET installation directory and loads various drivers
required for proper functioning of AlphaLAN 6.0 over AlphaNET. A sample
GOANET.BAT file is described below :

WD8003E 0x61 0x5 0x280 0xD000 ; The Clarkson packet driver gets
; loaded

ETHERNDV 0x62 ; Load the AlphaNET driver with
; interface set at INT 0x62
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ANDVR /A=62 ; Load AlphaLAN's Windows interface
; driver for one AlphaNET session. /A=62
; specifies that ETHERNDV is loaded at
; INT 0x62

C: ; Change drive to installation drive.
CD \ALPHALAN ; Change directory to AlphaLAN
GOALAN ; For EC+EP users, run GOALAN.BAT file

GOALAN.BAT

This file is used to start up DOS version of AlphaLAN 6.0. A typical GOALAN.BAT
file is shown below.

Set ORB=C:\ALPHALAN ; set ORB environment variable to
; installation directory

MINOR /A=62 ; For EC+EP users
CALL CALAN ; for AlphaNET users only
OPEN demo ; For EC+EP users, “demo” is user name on

; the host system

CALAN.BAT

This file contains a single line CTRM command:

CTRM H=am400 ; am4000 is the host name defined in the
; ALANHOST file

STOPALAN.BAT

This file is used to stop the DOS version of AlphaLAN 6.0. A typical STOPALAN.BAT
file may contain:

MINOR /A=62/D ; For EC+EP users

To start AlphaLAN 6.0 type 'GOANET <enter>'. This command  loads the packet
driver (WD8003E.COM, in our case), and also AlphaNET protocol driver
ETHERNDV. The above sample of GOANET.BAT shows the packet driver loaded at
interrupt number 0x61. The ETHERNDV automatically detects this interrupt. The
number specified along with ETHERNDV statement is the interrupt number that
AlphaLAN uses to communicate with ETHERNDV.

If you are an AlphaLAN EL user, go directly to Windows. For AlphaLAN EC and EP
users, GOANET.BAT file executes 'GOALAN'. This loads MINOR.EXE program in
memory connects your PC to your AlphaMicro host, and for EC+EP users starts the
server functions.

Now, you can go into Windows and run AlphaLAN icon to start your terminal window.
To modify AlphaLAN server functions double click on WINALAN icon from the
"AlphaLAN" group. Using this program, you can open/close communication with the
AlphaMicro host and select remote printers (For details on WINALAN program,
please refer to the AlphaLAN for Windows Users manual).

When you quit Windows, type 'STOPALAN <enter>' at DOS prompt to stop
AlphaLAN. The STOPALAN command disconnects the AlphaNET session and
unloads MINOR program from memory.
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F If you wish to use terminal emulation from DOS, you will need to change
GOALAN and STOPALAN files (change the line containing MINOR to ORBIT in
these files). If you are using AlphaLAN EL, you will also need to modify GOALAN
file. Please note that using ORBIT.EXE in place of MINOR.EXE  takes up much
more memory under DOS.

F ETHERNDV is the new 'Clarkson packet driver' compatible AlphaNET/PC 3.0
driver. Unlike the old AlphaNET driver this new driver can be used if you are
running multiple protocols on your PC. The new driver is also compatible with
Windows for Workgroups.

F The AlphaNET interrupt number should be specified from SETPC if you are using
the new AlphaNET/ PC 3.0 (ETHERNDV.EXE) with the Clarkson packet
interface. The AlphaNET interrupt 0x60 should only be used if ORBIT.EXE is
loaded with the /I=nn option and "nn" is not 60. The /I=nn option is used to specify
the interrupt number between ORBIT.EXE  or ANDVR.COM and AlphaLAN
windows programs. By default ORBIT.EXE or ANDVR.COM uses the interrupt
60H.

Notes for AlphaLAN 6.0 SCO IPX/SPX installations (Windows Only)

SCO IPX/SPX provides interoperability between DOS Workstation NetWare clients
and SCO UNIX Version 4.0 or Open Desktop Release 2.0 over the NetWare
network. AlphaLAN 6.0's Windows programs supports this IPX/SPX interface on PCs
connected in a Novell network to communicate with SCO UNIX hosts.

This interface eliminates the need for multiple protocol stacks in a Novell network. It
consists of three components:

l Kernel component, comprising of three stream drivers for supporting Novell's
Internetwork Packet Exchange (IPX), Sequenced Packet Exchange (SPX) and
Novell Virtual Terminal (NVT) protocol.

l User component, including a NetWare Protocol Stack daemon, a Novell Virtual
Terminal daemon and a Service Advertising Protocol daemon.

l DOS component, consisting of a DOS TSR (NVT.EXE) which acts as a network
redirector allowing a DOS user to establish a connection with an NVT server. It
requires IPX.COM (shipped with Novell server) to be loaded on DOS, in addition to
the device driver for the LAN card.

Installation instructions

l Make sure that the required LAN adapters and corresponding Link Level Interface
(LLI) drivers have already been installed and configured on the SCO UNIX system.
Install the UNIX component on the system (running SCO UNIX Version 4), by using
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the "custom", "netconfig" and "ipx start" commands. Please refer to SCO IPX/SPX
manuals and release notes for details.

l Please refer to Novell-distributed installation and configuration notes to configure IPX
for the chosen LAN adapter and network type. Copy NVT.EXE (from SCO IPX/SPX
diskette) to your hard disk and add the NVT command in the AUTOEXEC.BAT file,
after issuing the IPX command.

If you are using AlphaLAN 6.0 Windows programs over IPX/SPX then you need to
load the IPX/SPX driver and then from Windows, double click on the 'AlphaLAN' icon
in the 'AlphaLAN' group. Only terminal emulation is available over IPX/SPX interface.

Notes for AlphaLAN 6.0 TCP/IP installations (Windows Only)

AlphaLAN 6.0 Windows programs allows you to perform remote login (through
"RLOGIN" and TELNET) on multi-user host systems over TCP/IP. The host system
should have TCP/IP run time system installed on it. On the PC side, a TCP/IP kernel
providing standard Windows Socket API interface to Windows programs, e.g. FTP
Software Inc.'s PC/TCP network software should be installed. To be able to perform
remote login on a host system over TCP/IP, you should be connected to the host
directly through Ethernet or indirectly through gateways.

Appendix B lists the various WINSOCK complaint TCP/IP stacks supported by
AlphaLAN 6.0.

To get a list of hostnames in the “Connection Setup..” dialog box, you should have
the “HOSTS=“ entry in your WINORBIT.INI (or any other AlphaLAN INI file) point to
the HOSTS file (or table) of your TCP/IP stack. For example if you have FTP’s
TCP/IP stack, and its host file (specified in “host-table=“ entry in its .INI file) has an
entry like:

host-table=c:\pctcp\hosts

then, the “HOSTS=“ entry in AlphaLAN .INI file should be:

HOSTS=c:\pctcp\hosts

Please note that this entry is required only to allow AlphaLAN to get a list of pre-
defined host names. If you want to add any new host names, you should add them to
the above file.

This file should be in the format specified below and should contain the name and
internet addresses of the machines on your network. Following is the script of a
sample HOSTS file:

127.0.0.1 Loopback
20.0.70.1 bigalpha.com bigalpha
20.0.70.2 pc1.uas.com pc1
20.0.70.3 pc2.uas.com pc2
20.0.70.10 runix.com runix

First field specifies the internet address, second field specifies the canonical name
and the third field specifies the symbolic name of various hosts on the network.

After loading the TCP/IP kernel, double click on the 'AlphaLAN' icon in the
'AlphaLAN' group.
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Notes for AlphaLAN 6.0 INT 14 installations (Windows Only):

This interface allows you to use AlphaLAN 6.0 with IBM ROM BIOS INT 14H based
network redirector on a wide range of networks. To use AlphaLAN 6.0 with INT 14H,
install the INT 14H network redirector on the PC for COM1 or COM2 and from
Windows, double click on the 'AlphaLAN' icon in 'AlphaLAN' group. Select the proper
ports and parameters for INT 14H interface. Only terminal emulation is available over
INT 14H interface.

3. Description of New Features

3.1 File transfer over various modem protocols

The modem file transfer protocols supported are ASCII, XMODEM, YMODEM,
ZMODEM and KERMIT. The large packet variation of XMODEM often called
XMODEM-1k and the reliable link option of YMODEM called YMODEM-g are also
supported.

ASCII

This protocol consists of reading each byte of data from a file and transmitting it. It is
used for readable text files only. Data is sent on a character by character basis and
to the receiver it appears as though data has been entered from a keyboard. The
receiver can save, display or discard the data.

XMODEM

In this protocol the sender and the receiver synchronize by sending a fixed size of
data at a time. XMODEM is a simple send and wait, automatic repeat request (ARQ)
flow control protocol. The packet contains header fields, a data field and an error
check trailer. Using the header fields and the trailer, each packet is verified before
the next packet is transmitted. The data field is of 128 bytes but padding bytes are
inserted if the file size is not an exact multiple of 128. Therefore, the file size on the
sender and receiver sides may not match.

Since, both sender and receiver wait for specified characters in order to synchronize
their actions, time-outs and retry limits are required. Both binary and text files can be
transferred using this protocol.

XMODEM-1k

This protocol is an extension of the standard XMODEM protocol. But instead of the
128 bytes data field, 1024 bytes data field is used. However, as in the case of
XMODEM, padding bytes are inserted if the file size is not an exact multiple of 1024.
If line conditions are poor, the sender may step down to a smaller packet size.

YMODEM

Multiple files can be transferred using the YMODEM protocol. Unlike ASCII,
XMODEM and XMODEM-1k, the file length is also transmitted. Large packet (data
size 1024 bytes) are supported. This protocol can be used for both binary and text
files.
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YMODEM-g

It is a derivation of the standard YMODEM protocol in which the sender sends data
continuously (or blocks one after the other) without stopping. Therefore, it is also
referred to as a full streaming protocol. YMODEM-g assumes that the link is error
free and any error cancels the transfer.

ZMODEM

ZMODEM is a packeted, full streaming protocol with failed transfer recovery
features. It can also configure its streaming techniques to accommodate systems
which are incapable of the full streaming throughput. The sender in this case can
shorten the packet size to 512 or 128 bytes. Furthermore, ZMODEM can emulate
YMODEM, thereby providing compatibility with many systems. Besides the general
transfer options of other protocols, ZMODEM provides certain "Advanced Options".
Both binary and text files can be transferred using this protocol.

KERMIT

This protocol has the feature of supporting file transfers in a 7 bit format. Since all the
data is transmitted within the range of printable ASCII characters, data encoding and
decoding is required, which allows KERMIT transfers to work without errors under a
variety of operating systems and terminal types. Using this protocol you can transfer
both binary and text files.

3.1.1 File transfer on AlphaLAN for Windows

3.1.1.1 Selecting File transfer protocols

For file transfer to/from the other machine you can select a particular protocol from
the File Transfer Protocol sub-menu of "Settings" menu.

3.1.1.2 File transfer options

You can modify options for file transfer from the Transfer Options" sub-menu of
Transfer menu. A dialog box appears as shown:

If you want to set default values for all the fields, click on the Default button. The
various options in this dialog box are explained below:
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Protocol

Use this option to change the currently selected protocol. After you have changed
the currently selected protocol, the settings for that protocol will appear in the dialog
box. Some options will be disabled (grayed) for some protocols.

Error Check Method

Using this option, you can change the error checking method used for file transfer.
The error checking methods supported are:

1 byte Checksum
2 byte CRC(CRC-16)
16 bit Checksum
32 bit CRC

Please note that some of these error checking options are not available for all the
protocols.

File Type

Two types of files can be transferred. These files are:

Text files
Binary files

In case of text files only printable ASCII characters can be transferred. But in binary
files printable characters, control characters and binary characters can also be
transferred. In binary file LF to CRLF conversion is not valid.

General Options

These options are :

l Overwrite existing file
If this option is selected and a file which already exists on the receiver side is
transferred by the sender, then that file will be overwritten. This option is disabled in
ZMODEM and the advanced options dialog box shows the overwriting options in this
case.

l Set current date/time
If this option is selected, the date and time of file are set from the system. In order to
leave the date and time unchanged when the files are received, deselect this option.

l Ignore path
This option causes the received file(s) to be placed in the current working directory
regardless of any transmitted file path. While transmitting file(s), any path specifier is
removed from the file information block before it is sent, if this option is selected.

l Transform control characters
This option is used to encode control characters (ASCII characters whose values are
less than 32). When this option is specified, all control characters are transformed
(escaped).

l Transfer 8 bit data as 7 bit
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This option allows to transfer binary files (those with 8 significant data bits per
character) using just 7 data bits. It is a standard KERMIT option. If selected, it
encodes 8 bit characters to 7 bit.

l Translate LF to CRLF
This option translates single line feed characters into a line feed and carriage return
combination. It is valid for text files only and can be specified for all the protocols.

l Pack characters
If this option is selected, then a group of repetitive characters can be sent more
quickly by marking them with a special escape character. It can be specified for all
the protocols.

F Note : Transform control characters, Transfer 8 bit data as 7 bit, Translate LF to CRLF
and Pack characters options will work only if sender and receiver both have selected
these options.

Retries

Number of retries specifies the number of times the packet is to be sent, if
acknowledgment is not received.

3.1.1.3 Saving/Changing file transfer options

You can save file transfer options by selecting "Save" or "Save As" buttons in the
"Transfer Options" dialog box. The "Save" option updates the current options file,
while the "Save As" option prompts you for a separate file name.

If you want to load options saved in some other file, you can choose "File" button. A
dialog box will be displayed with a list of file names (with extension .MOD) in current
working directory, from which you can select any file.

3.1.1.4 Advanced options for ZMODEM

In addition to the file transfer options explained above, ZMODEM protocol allows you
to set certain other options. Use "Advanced" button in "Transfer Options" dialog box
to set certain advanced options available in case of ZMODEM protocol. The following
dialog box appears on clicking this button:
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Clicking on the default button will set all the fields to their default values. Following
are the various options available.

l File must exist at receiver
The transfer will take place only when the file exists on receiver side. This option is
useful for transferring a file only if a previous version of that file exists on the receiver
side.

l Resume transfer
This option helps to resume an interrupted transfer. You cannot use this option for
transferring file for the first time. This option is to be used only when you want to
resume the last unsuccessful transfer of the same file.

l File Management option
These options allow the conditional transfer of files. Transfer if absent option and File
must exist at receiver options are mutually exclusive.

3.1.1.5 Sending Files

To send a file, select the "Send" item from the "Transfer" menu. A dialog box
appears as shown below:

Using this dialog box, you can select a single file or multiple files to be transferred.
You can also specify wild card options in the wild card edit box. Multiple files are not
allowed in ASCII and XMODEM file transfer protocols. To send the file(s), click on
the OK button. A dialog box showing the file transfer status appears as shown:
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The progress bar shows the percentage of file transferred. To cancel file transfer,
click on the "Cancel" button.

3.1.1.6 Receiving Files

To receive a file, select the "Receive" item from the "Transfer" menu. In case of
XMODEM and ASCII file transfers, a dialog box appears as shown below:

You can select the name of the file that is going to store the received data(file). After
this, a dialog box showing the status of file transfer will appear (like the one in case
of "Send").

3.1.2 File transfer on AlphaLAN for DOS

3.1.2.1 Getting started

Before starting file transfer, make sure that ORBIT is loaded in memory and
configured for the correct port. Start file transfer program by giving the following
command at the DOS prompt.

XFER filename <cr>

where filename (default XFER.INI) is the configuration file that initializes XFER on
startup.

A word about Configuration file

Customized configuration file can be created for file transfer. "Open ..." option in the
"File" menu allows you to load the configuration from the specified file. The "Save ..."
option updates the current configuration file while the "Save As..." option prompts
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you for a file name to save the configuration. Different configuration files for different
communicating sides prevents repeated settings of protocol, options etc..

3.1.2.2 Protocol selection

You can select a particular protocol by selecting the "Protocol ..." option of
"Transfer" menu. A dialog box would appear whereby you can select the desired
protocol. The protocols supported are ASCII, XMODEM, YMODEM, ZMODEM and
KERMIT. The large packet variation of XMODEM often called XMODEM-1k and the
reliable link option of YMODEM called YMODEM-g are also supported.

3.1.2.3 File Transfer Options

Select "Option" in the main menu bar to set file transfer options. The Option dialog
box appears as shown below.

The above options work exactly as in AlphaLAN for Windows. Please refer to section
3.1.1 for a detailed description.

3.1.2.4 Advanced Options for ZMODEM

In addition to the above mentioned file transfer options, ZMODEM protocol allows
certain other options to be set. Select the "Advanced Option..." item in "Transfer"
menu to change ZMODEM advanced options. A dialog box displaying the file
management and other options pops up.
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The various options available are same as in AlphaLAN for Windows and are
described in section 3.1.1.4.

3.1.2.5 Port Parameter settings

Port settings can be changed by selecting the "Port Parameter" option in the main
menu. A dialog box appears, which allows you to change the following parameters:

Œ Baud rate
• Data bits
• Parity bits
• Stop bits

Checking the "Restore ORBIT parameters " in the dialog box causes the port to be
restored to the configuration that existed prior to the execution of XFER.

3.1.2.6 Sending file(s)

To send a file, select the "Send..." item from the "Transfer" menu. The dialog box
which appears, prompts you for a file name. Using this dialog box, you can select the
file to be transferred. To send the file click on the "OK" button. A dialog box showing
the file transfer status appears as shown:

3.1.2.7 Receiving file(s)

To receive a file, select the "Receive" item from the "Transfer" menu. In case of
XMODEM, X MODEM -1K protocols and ASCII protocols, a dialog box appears,
prompting you for a file name.

You can select the name of the file that is going to store the incoming data(file). After
this, a dialog box showing the status of file transfer will appear like the one in case of
"Send".
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The progress bar shows the percentage of file transferred. To cancel file transfer,
click on the "Cancel" button.

3.2 Selectable foreground color in AM70/WYCOL emulation

3.2.1 In AlphaLAN for DOS

On color field terminals such as AM70/ESPRIT III, whenever you set the background
color the foreground color always switches to black, as it can hold only one attribute
at a time. If you set an environment variable, FDCOL, before loading ORBIT (by
giving the DOS command, SET as explained below), you can define the foreground
color to be something other than black.

The FDCOL variable is defined as follows

SET FDCOL=01234567

The eight positions in FDCOL variable correspond to the eight background colors, as
follows:

position # Corresponding background color

0 green
1 cyan
2 yellow
3 white
4 black
5 blue
6 red
7 magenta

Following are the codes assigned to different foreground colors.

color code color

0 black
1 blue
2 green
3 cyan
4 red
5 magenta
6 yellow
7 white

To select a particular foreground color for a specific background color, you may
specify the foreground color code at the FDCOL variable position corresponding to
that background color. After this FDCOL variable is set, whenever you change the
color through your host program to that specific background color, the foreground
letters will appear according to the foreground color specified in the FDCOL variable.

For example, if you would like white foreground letters on blue background, FDCOL
variable can be set as:

set FDCOL=0000070  or,
set FDCOL=000007
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Similarly, for Yellow on black and white on blue, you can define

set FDCOL=0000670  or,
set FDCOL=000067

This variable has to be defined in the environment before ORBIT is loaded. Best way
to do this is to place this statement in your AUTOEXEC.BAT file before you load
ORBIT.

3.2.2 In AlphaLAN for Windows

As in the case of AlphaLAN for DOS, you have to set the FDCOL  variable (user
editable only) in .INI file for any foreground color on any background color. For
example, if you want white on blue color you can define the FDCOL (in the
initialization file) as follows:

FDCOL=0000070  or,
FDCOL=000007

3.3 New Terminal emulations/features in AlphaLAN/FW

AlphaLAN/FW 6.0 now emulates two new terminals, AM62C and PCFM. ANSI
emulation has been improved to provide support for 8 bit graphic characters.
ESPRIT III emulation now supports 4 pages. bi-directional port support has been
added to WYSE50 emulation.

PCFM - Native "Field" Terminal Emulation with "Mode" colors

The various features supported by this new emulation are field attributes, mode
colors, and standard TCRT support (in case of AMOS). You also have support for
save/restore screen area, alternate page, 132 column and 42/49 row screens,
protected fields, window style boxes, set date/time, horizontal split, top and bottom
status lines, ANSI color commands, mouse, etc.. To select this emulation you have
to use our new terminal driver PCFM.TDV on the AMOS side and select NATIVE on
the Windows side.

AM62C Emulation

This emulation allows your AMOS programs to use AM62A emulation (field
attributes) with AM72/AM75 style mode colors.

3.4 Phone Book for DOS

Phone Book can be executed from the command line by giving the command :

PB filename <cr>

where <filename> is the Phone Book file. PHONE.PB is the default Phone Book file.
This causes the following screen to appear:
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A number can be dialed using Dial  option on the menu, or by pressing Enter at the
desired phone record.

The main functions provided by the phone book are:

Œ Allow the user to Add/Modify/Delete a Phone Book record.

• Dial a number (highlighted entry in the Records list), at  the specified time and
date(delayed dialing).

• The user can switch between the Menu bar and the Records list by using the Alt key
(plus the highlighted key in the menu bar) combination, or just the Alt key.

• In the records list the entries are displayed in a sorted order (ignores case of the
characters), and the user can search through the list by pressing the first character
of any name.

The menu options available are:

File
"Open" item in the "FILE" menu allows you to load phone records from an existing
Phone Book file. The "New" item allows you to create a new Phone Book file. The
"Save" item updates the current Phone Book file, while "Save As" item prompts you
for a file name to save the records.

Dial
This option dials the number from the currently selected record in the Phone Book
Records list. If any value is specified for the time and/or date (displayed in the
information window), the number is dialed at that time, otherwise it is dialed
immediately. The user can exit out of the dialing sequence by pressing Esc .

F Note:   The following baud rates are supported - 300, 600, 1200, 2400, 4800,
9600, 19200, 38400 and 57600.

Mode
The user can select between ATDT / ATDP (Tone Modem / Pulse Modem) by using
this option. Currently selected option is displayed in the information window. The
default mode is ATDT.
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Hang
To terminate the dialed connection, select this option.

Add
This option adds a new entry in the Phone Book. Unless both the name and phone
number are not specified, the new entry is not added to the Phone Book.

Modify
This option allows the user to modify an existing entry. If the record is changed, the
file is marked as modified (an asterisk(*) appears along the file name in the status
bar).

F Note:  If a previous value for date and/or time is specified, and the user wants to
dial immediately, he can erase the old values by entering all 0's in those fields.

Delete
This option deletes the selected record, without any confirmation.

Status
The user can view the last connected numbers (day and time), connection time and
other information using this option.

Quit
This option quits the Phone Book. In case the file has been modified, the user is
prompted to save the modified file.

3.5 Tool Bar

You can use the tool bar for quick access to commonly used commands of
AlphaLAN/FW like open and save configuration, clipboard operations, dial, hang-up,
etc.. The tool bar, just below the menu bar of terminal window displays the buttons
for some commonly used commands. Clicking on the button will perform the function
assigned to the button. The status bar displays the function associated with each tool
bar button. You can display or hide the tool bar from the "Tool Bar" option of "View"
menu.
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You can display or hide the tool bar from the "Tool Bar" option of "View" menu.

Customize Tool Bar

You can add, delete, move or regroup buttons on the tool bar to best suit the way
you work. A dialog box will be displayed when you select "Customize Tool Bar" from
"Tools" menu.

Current tool bar buttons and available buttons are listed separately in the dialog box.
To add a button, select the button to be added in "Available Buttons" list and select
its position in "Tool Bar Buttons" where it is to be added and then choose the "Add"
button. You can remove any button from "Tool Bar Buttons" by selecting it and
clicking on "Remove" button. Separators can be used to adjust spacing between
buttons. You can restore the default tool bar by choosing the "Default" button.

3.6 Border Color and Pattern

In AlphaLAN/FW, font size is selected so that the entire text on the page fits into your
window. If the text displayed in the selected font size does not fill the entire window,
the application text is centrally placed within the window. The pattern and color of the
surrounding "border area" is user selectable. Selection can be made through the
"Border Color" item of "Display Options" sub-menu in "Settings" menu.

"Border Color" displays the Windows standard color selection dialog box from which
color can be chosen and created. Pattern can also be selected from this dialog box.
To define a color of your own, click the "Define Custom Colors" button. It displays
custom colors. You can select one of the 16 rectangles in this control and then
create a new color by using one of the following methods:

� Specifying red, green, and blue (RGB) values by using the Red, Green, and Blue edit
controls.

� Moving the cursor in the color spectrum control (at the upper-right of the dialog box)
to select hue and saturation values.

� Specifying hue, saturation, and luminosity (HSL) values by using the Hue, Sat, and
Lum edit controls.

To display a newly created color in the selected rectangular box, click on "Add to
Custom Colors". You can select any of the colors (basic or custom) to fill the border
area.
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3.7 Status Line

The status line shows a single line help for the currently selected menu item. Also, if
you move the cursor on a Tool Bar icon, the corresponding help text would be shown
on the status line. AlphaLAN looks for its initialization files in the current working
directory. By default, the installation directory is the working directory. Similarly, all
the file transfer is done either from the “upload” directory (for sending files to a
remote system) or to the “dnload” directory (for receiving files on your PC). You can
set the current directory, the upload directory and the download directory to any
directory of your choice. If you select the option “Directories...” from the “File” menu
bar item, a dialog box appears, showing you the current selections for these
directories. You may change them according to your need.

3.8 User Defined Keys

You can assign your own labels and multiple character sequences (maximum 20
characters) to as many as 64 user definable keys. These keys are displayed in four
groups of sixteen keys each, either at the top or at the bottom of the terminal
window. Choose "Top" or "Bottom" after selecting the "User Defined Keys" sub-menu
of the "View" menu. Choose "None" from the same sub-menu to hide the template.

For example, you can define a template for UNIX commands which may look like the
following:

3.8.1 Using the UD Keys

At a time, 16 buttons for 16 keys of one level along with a master button showing the
name of level will be displayed on the screen. If you have not specified any name for
level then the master button will show "LEVEL 1" for first level and "LEVEL 2",
"LEVEL 3", "LEVEL 4" for second, third and fourth levels respectively. You can click
on the master button (level name button) to switch between different levels.

You can select any key in the current level by clicking on the corresponding button.
For selecting a key from other levels, you can either change the level using master
button and then click on that button or you can click on the corresponding button in
the current level along with pressing the modifier key for that level. The modifier keys
for different levels are :

Level Modifier key to be pressed
1 none
2 shift
3 control
4 alt

Suppose you have defined the command for key1 as "ls" in first level and "clear" in
second level, you can send the "clear" command from the first level by pressing the
"shift" key and clicking on the first button.

F Note : You cannot select a key of LEVEL1 from other levels, i.e. you can select a key
from LEVEL1 only when master button is set to LEVEL1.
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3.8.2 Programming of UD Keys

The user defined keys can be programmed using the dialog box that appears on the
screen when you select the "Define User Keys..." option from the "Tools" menu.

This dialog box (shown below) has 16 keys which you can define for 4 levels. Select
the key that you wish to define. The labels and contents of the selected key for all
four levels will be displayed in corresponding boxes and the group box will show the
selected key number. For example, the above dialog box shows the information of
K1 key and the title of group box is set to "K1".

You can define the key to perform one of the following two functions.

� TEXT - for sending the contents of the key to host.
� PROGRAM - for executing the program whose name is specified in contents of the

key.

The field "CR" specifies whether a carriage return is to be sent to the host along with
the command sequence. In case of UNIX, sending carriage return may be useful in
commands like "ls", "vi" etc.. However, this field is irrelevant in case you have
specified the type of key as PROGRAM.

You can assign a label to the key in the "Label" field. This label will appear on the top
of the button in the terminal window.

The names of the levels can be entered in the "Level Name" field.

For TEXT type of keys, you can enter the string to be sent to host in the ‘Content’
field. For Program type of keys, enter the name of the executable. Full path has to be
specified, if the executable is not in the current directory.

The contents of key can be entered in three modes — character, hex or decimal. In
hex and decimal modes, the characters are separated by spaces. The valid range for
hex is 00 to FF and for decimal it is 000 to 255. You can enter non alpha-numeric
characters in hex and decimal mode only. The control characters entered in hex or
decimal mode are displayed as control character when you are back in character
mode. For example, the control-C of LEVEL2 in the above dialog box will be shown
as 03 in Hex mode. The Hex mode display of the previously displayed dialog box is
shown below:
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Saving and loading of UD Keys data

You can save the settings of user defined keys using the "Save" and "Save As"
options. The "Save" option allows you to save settings in the current file and the
"Save As" option allows you to save the settings in some other file. By default the
user defined keys are stored in the WINORBIT.UDK file, but you can specify any
name.

Use "File" option to open some other .UDK file. You can also use "File" option to
create a new file.

The name of the UDK file which is currently active will be saved in the current .INI file
when you save AlphaLAN configuration. To see the name of the currently active
.UDK file, go to “Customize Keyboard” in “Tools” menu. The name of the current
UDK file is displayed in the Window title.

3.8.3 Keyboard Remapping

You can customize the PC keyboard to match the keyboard layout of the terminal
you are familiar with. To do this “Keyboard Remapping”, use the "Customize
Keyboard" option of "Tools" menu. It displays the following dialog box:
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Codes for the selected key are displayed in "Transmit - Key" group box. These key
codes can be different for different terminals. You can select the desired terminal
from "Terminal Type" list. Key codes for a selected key can be set for all the
terminals using the "Set for all terminals" button. To map the Num lock key, you have
to check "NumLock Mapped" check box. If it is checked, “Num Lock” key can no
longer be used for toggling numpad keys.

You can change the codes for any key in the Edit Key dialog box which
appears when you double click on that key (or press space bar on the selected
key) . In this dialog box you can enter the codes in any of the three modes -
character, decimal or hex. Maximum length of a key code (sequence) can be 19
bytes.

You can set the default codes using the "Default" button in the dialog box. Mapped
sequences can be saved using the "Save" and "Save As" options. The "Save" option
allows you to save settings in the current file and the "Save As" option lets you save
the codes in some other file. By default, the user keyboard re-mapper file is named
as WINORBIT.KBD but you may specify any other name. We recommend that you
use the .KBD extension for all your keyboard re-mapper files.

Use "File" option to open some other .KBD file. You can use "File" option to create a
new file also.

Clicking on ‘OK’ will save the changes, if any, in the current file, and also activate it
for current use. The name of the currently active keyboard re-mapper file will be
saved in the current .INI file, when you save the AlphaLAN configuration.

To enable the current mapping of the keyboard, select "Enable Keyboard
Mapping" option from the "Preferences" menu.

F Note : The new enhanced 6.0 keyboard remapper is not compatible with the keyboard
remapping functions of earlier versions of AlphaLAN. Therefore you will need to re-map
your keyboard once again in AlphaLAN 6.0 as your previous “settings” would be “lost”.

3.9 Advanced Configuration Options

There are certain special ".INI" settings that can be modified using a text editor. The
format of the ".INI" file is like any other Windows ".INI" file. The ".INI" file is divided
into three sections.

Œ [USERPREF]
• [COMMPREF]
• [MENUPREF]

Each of the sections has relevant settings that can be modified from the Menu bar of
AlphaLAN/FW. Appendix A of the user manual describes each of these settings.
There are some new settings that cannot be modified from the menu bar but may be
changed using any text editor to suit your specific needs. These settings are as
follows.

3.9.1 Fast Field Emulation

Under [USERPREF]
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FFE=<TRUE/FALSE>

This specifies whether to use fast screen drawing logic in case of field terminals. By
default it is TRUE. Normally, this setting should not be changed.

3.9.2 Scan rate for incoming data

Under [USERPREF]

DATASCAN=<N (integer greater than or equal to 0)>

Non zero value of DATASCAN specifies the time delay for polling the port for data
coming from the host. Scan rate is fastest with DATASCAN set to zero. The default
value is 10.

3.9.3 Shut off printer

Under [USERPREF]

SHUTOFFPRINTER=<TRUE/FALSE>

All the printing sequences from the host will get ignored if this entry is set to TRUE,
i.e. printing will not be possible. By default it is FALSE. You can change it to TRUE, if
you do not wish AlphaLAN to print any host data to your PC printer. This may be
useful if you are connected over the modem and AlphaLAN keeps sending data to
your PC printer whenever there is a disturbance on the phone line. Please note that
if you change this setting to TRUE all printing including Transparent / Bi-directional
print and printing through “ALP” driver will stop.

3.9.4 Save/Restore pages

Under [USERPREF]

SAVRESTPGS=<# of pages>

The default value is 4.

3.9.5 Secondary Port for Bi-directional mode

Secondary port for bi-directional mode can be defined in .INI under the section
[SECONDARY].

[SECONDARY]

BAUD=<300/600/1200/2400/4800/9600/19200>
PORT=<COM1/COM2/..../COM8>
PARITY=<ODD/EVEN/NONE>
STOPBITS=<1/1.5/2>
BYTESIZE=<5/6/7/8>

These port parameters should match with those on the device connected to the
secondary port. AlphaLAN can take input from this secondary port and relay it to the
host system. This can be used to attach devices like “weighing scale” etc. to your
PC.
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3.10 FRCTRM to return DOS ERRORLEVEL

If you specify /E parameter with the new FRCTRM, it will return error code to DOS
applications calling FRCTRM. For example, if a file could not be transferred
successfully (using CPC/CALF commands), and  “Remote not responding” error
occurs, FRCTRM will return the ERRORLEVEL 1 to DOS. This could further be used
in a batch file and the appropriate action may be taken. A sample batch file is shown
below:

@echo off
frctrm /e /calf /g orbit.exe
if ERRORLEVEL 1 goto END
frctrm /e /cpc /g test.bas
if ERRORLEVEL 1 goto END
echo No Error
goto over
:END
echo Error Occured
:over

The second line forces the command "calf /g orbit.exe" on AMOS. The "/g" option of
CALF returns you to the DOS prompt after the file transfer. If the transfer is
successful, the fourth line would be executed and a file (TEST.BAS) will be
transferred to your PC. If there is no error, you will see the "No Error" message. In
case, an error occurs in either of the two transfer commands, a “Remote not
responding” error is generated and the value of ERRORLEVEL becomes 1. This will
terminate the batch file after giving the message “Error Occured”.

You can do without the "/g" option in the above example as explained below:

Select "Switch to DOS on screen saver time-out" from the SETPC program [execute
SETPC, select "Terminal", go to "Preferences" and select "Switch to DOS on screen
saver time out" as "ON" by pressing the space bar. Then select a small value (say 5
seconds or 10 seconds) for the Screen Saver Time-out from the "Screen Saver..."
option of SETPC]. Now save the file. Reload ORBIT. Change the sample batch file
as shown below:

@echo off
frctrm /e /calf orbit.exe
if ERRORLEVEL 1 goto END
frctrm /e /cpc cpc.m68
if ERRORLEVEL 1 goto END
echo No Error
goto over
:END
echo Error Occured
:over

3.11 Destination file name in Native file transfer (CPC/CALF)

You can now specify the destination file name(s) during file transfers over an
AlphaMicro host (using CPC.LIT or CALF.LIT).

The destination file name could be any valid DOS file name (while transferring files to
PC), or any valid AMOS file spec (while transferring files to the AMOS system).
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For example, If you want to transfer all the files with “CMD” extension from the
AMOS host to the PC as files with the extension “BAT”, give the following command:

CPC  *.CMD  *.BAT

Similarly, for transferring files to an AMOS host from your PC, give the following
command:

CALF  AUTOEXEC.BAT  AUTOEX.CMD

3.12 Auto Dial on Startup

The Winorbit program can automatically dial out a selected number whenever it is
started. This number can be set from the Phone Book dialog box that appears on the
screen when you select the "Phone Book" menu item from the "Modem" sub-menu of
"Tools" menu. For setting a number for auto dial, select the entry for that number
from the listbox and then click on the "Set for Auto Dial" button. The name and the
current phone file name would appear in the "Auto Dial" group box. After that check
the "Auto Dial on Startup" button. This number would now be dialed automatically
every time you start AlphaLAN/FW. Uncheck the “Auto Dial on Startup” button to
disable “Auto Dialing on Startup”.

3.13 Finger

The Finger application allows you to query any host system that is on the
network for information about the users currently logged on to the host. It
allows you to get more detailed information about a particular user or all the
users. You can also request the host to redirect the query to another host
system. This can be used to get information about a host that is not directly
connected to your network.

3.13.1 Using Finger

To Finger a host connected to your network, be it an internal network or
Internet, double click the Finger icon to start the program. Select the “Finger
Host” option from the “File” menu item or press F2 key and the following
dialog box will pop up.

Enter the name or IP address of the host system you wish to query in the
“Host” edit box, or use the pull down list box to choose from a list of systems
that have been already queried. When only the host address is specified,
Finger will display information about all currently logged in users. Finger is
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likely to show user’s login name, the full name, the terminal, the login time,
the idle time registered since the last command executed, the office location,
etc. depending on the, settings of the Finger Server running on the host
system.

If you specify the user name along with the host name, Finger will attempt to
display detailed information about the remote user. This information may
contain the phone number and the contents of the user’s profile and plan
files, if any.

When “Long Format” is selected, the remote host is requested to perform a
long listing of relevant users. If you select a Secondary Host, the remote
host is requested to get the listing from the secondary host.

You may clear the buffer by selecting “Clear Screen” from the “Option” menu
item. For help, press F1 key. You may also select the “Help” option from the
“Help” menu to get help.

3.14 Using GRAPH with AlphaLAN for Windows

AlphaLAN 6.0 provides you a new GRAPH.SYS program that supports both the
traditional graph functions for “non-Windows” workstations like AM72 and PC’s with
AlphaLAN for DOS and PEG and the “Windows” workstations using AlphaLAN for
Windows and PEG. It provides graphing and charting functions without any change
required in the user programs on Alpha Micro side. This function is active only when
the Infront terminal driver (PCI.TDV) is selected on AMOS side and PEG option of
AlphaLAN has been installed on your Alpha Micro. PEGINI should be loaded in the
system’s memory.

The seamless integration of a charting facility into AlphaLAN for Windows
(AlphaLAN/FW) is due to the presence of Graphics Device Interface (GDI). Graphics
Server, which is visible only as an icon, responds to requests from AlphaLAN/FW to
generate graphs from data passed to it. All the software is automatically installed on
your desktop, when you install AlphaLAN for Windows on your PC.

To test the Graph for Windows:
· Make sure that AlphaLAN 6..0 and PEG is installed on your AlphaMicro.
· Make sure that AMIGOS.SYS, GRAPH.SYS and PCI.GDV are loaded in system

or user memory.
· Make sure that you are suing PCI driver on your PC job.
· Log  to IMG:. Type “DSPGRF energy”. AlphaLAN should display the graph.

Setting Graph Options

Graph options can be selected from "Graph Options" dialog box, in the "Tools" menu.
The following dialog box will appear :
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All the options are described below :

(i) Stretch graph to Window size :  If this option is selected, the graph will be stretched
to the window size. The horizontal and vertical scroll bars will remain disabled.
However, if this option is unchecked, the graph size will remain same, irrespective of
the window size.

(ii) Use horizontal scroll bar :  This option can be enabled only when “Stretch graph to
Window size”  is unchecked. When the window is re-sized, the horizontal scroll bar
can be used to view the graph horizontally.

(iii) Use vertical scroll bar :  Similar to the horizontal scroll bar option mentioned above,
the vertical scroll bar is enabled, only when the “Stretch graph to Window size”
option is unchecked. When the window is re-sized, the vertical scroll bar can be used
to view the graph vertically.

(iv) Center the graph :  Select this option, if you wish the graph to be centered in the
window.

(v) Enable print option :  The "File" menu in AlphaLAN/FW provides an option to print
graphs on the printer. However, this option is enabled only when the "Enable print
option" is checked in the graph options dialog box.

(vi) Enable maximize button :  The maximize button in the graph window will be
enabled, if this option is checked.

(vii) Enable minimize button :  The minimize button in the graph window will be enabled,
if this option is checked.

(viii) Enable system menu :  The system menu in the graph window will be enabled, if
this option is checked.



Page 46

(ix) Close all graphs on clear screen :  If this option is checked and "clear screen"
sequence is received from Alpha Micro, all the graph windows that are currently
displayed will be closed. The maximize button in the graph window will be enabled, if
this option is checked.

(x) Display all graphs as 3D :  To view graphs in 3 dimensional form, you may select
this option. Otherwise, the graphs will be displayed in 2 dimensional form.

(xi) Display warning before displaying a graph :  If the graph number to be drawn,
exceeds the maximum no. that can be drawn at a time, the next graph will overdraw
the first one and so on. But a warning that a particular graph will be overdrawn will be
displayed, if the above option is checked. It is advisable to keep this option checked
always, in order to avoid unwanted overdrawing.

(xii) Save graph size and position :  The size and position of the last graph drawn can
be saved, if this option is selected. The new graph will be displayed in the same size
and position as the previous graph. If this option is not selected, the graph window
will be displayed in the default size irrespective of the size and position of the last
graph.

(xiii) Maximum number of graph windows :  The maximum number. of graphs that can
be drawn at a time, is given in this option. If the graph to be drawn exceeds this
number., the existing graphs will be overdrawn one by one.

After selecting the options, select the Ok button, or else, Cancel the modifications, if
any. For default settings in the "Graph options" dialog box, select the Default button.

Displaying the graph(s)

To display a particular graph, you can give the command DSPGRF <GDF
FILENAME> on the Alpha prompt. The data that is collected and analyzed by
AlphaLAN/FW will be handled by Graphics Server to render it in graphical and
charting form.

The .GDF (graph definition file) on Alpha side, consists of a series of single line
definitions that define both the content and format of the graph to be generated. For
details, please refer to the AMOS Terminal System User's Guide.

The various types of graphs available are :

¨ Line graphs
¨ Pie graphs
¨ Clustered Bar graphs
¨ Stacked Bar graphs
¨ Area graphs
¨ X-Y graphs.

These graphs are drawn on the basis of the data that is read from the .GDF file.

Printing the graph(s)

The contents of the graph windows and views can be printed on any Printer
connected to your “Windows” workstation that supports graphics printing. For this,
the "Print Graph" option should be selected from the "File" menu. The graph to be
printed can be selected from the list of graphs that are displayed in this dialog box.
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Otherwise, multiple graphs can also be selected. If only one graph is displayed, that
graph will be printed and the dialog box will not pop up.

F Note:  The print option will be enabled only if the "Enable print option" is selected
from the "Graph Options" dialog box.

Closing the graph(s)

The graph(s) that are displayed, can also be closed by selecting the "Close Graph"
option in "File" menu. If only one graph is displayed, that graph will be closed,
otherwise one or more graphs to be closed can be selected from the "Close Graph"
option's dialog box. If all the graphs are closed, the Graphics Server will also be
closed. However, on the next DSPGRF <GDF FILENAME>, the Graphics Server will
be re-opened.

F Note:  Graphics Server should not be closed while the application is still active. If
this is done, then all the active clients of Graphics Server will lose their graphics
services.

Limitations of using Graph with AlphaLAN for Windows

· Only vertical bar graphs are supported in AlphaLAN/FW. If the legend names are
very long, use <SP> as a delimiter to display the legend names.

· Graphics text attribute and fonts are not supported.

3.15 AlphaLAN FTP

AlphaLAN FTP uses the Windows Socket, thus allowing you to use it over various
Windows TCP/IP stacks compliant with Windows Sockets Version 1.1 and above. It
consists of a File Manager like drag and drop front end, for local and remote files. In
addition it supports the command line interface to automate file transfer using
macros.

3.15.1 Starting FTP

The install program of AlphaLAN adds an icon named "FTP" in the program group
"AlphaLAN". You can start FTP by clicking on this icon. FTP may also be launched
by clicking the corresponding toolbar button or by selecting the menu item "Launch
FTP" from the "Transfer" menu in AlphaLAN for Windows.

3.15.2 The FTP Window

The FTP screen is divided into two main regions with each region further divided into
small windows. The top region shows the directory structure of Local side and the
bottom region shows the one for Remote side. The currently selected region is the
one shown as highlighted and you can select a region by clicking on any point inside
that region.
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Toolbar

A toolbar is provided below the menu bar to allow easy access to the commonly
used commands. All commands available on the Toolbar are also available in the
menu. You can hide this toolbar by deselecting the "Tool Bar" item of "Options"
menu. The functionality of each toolbar button is shown in the status bar when the
mouse points to that button.

Status bar

The bottom area of FTP window has a status bar. The various messages displayed
on this status bar are :

1. The reply strings coming from the remote in response to various commands sent to
it.

2. The on line help of the currently selected menu item.
3. The functionality of toolbar buttons when mouse is moved on them.
4. The file transfer information like total no. of files, files transferred successfully, rate of

transfer etc..

When none of the above listed messages is shown, the status bar shows the
information about the remote side connection.

3.15.3 Connecting to remote system

When AlphaLAN FTP is started the connect box appears on the screen asking for
the host name to connect to. You can also use the, the "Connect" menu item, the
toolbar button or the host box in the remote region to connect onto remote system.
The connection dialog box that appears on the screen is shown below.
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To log into a remote host:

l Enter the host name, user login name, password and account name, if required of
the remote system. The "Host Name" drop down box shows a list of previously
accessed hosts. You can choose a name from this list or type in a new name. You
can also enter the IP address of remote system in this box. If you specify the host
name, make sure that you have defined this name in the hosts table of the
underlying TCP/IP kernel.

l The "System" drop down box shows a list of system types supported by AlphaLAN
FTP. They are Windows , UNIX, Macintosh  and AMOS. You can select any one of
them depending upon the system at remote side. By default System shows UNIX
host, change it to AMOS while connecting to AlphaMicro hosts . If the system on
remote side is none of these, or you are not sure about the file structure of remote
system, select Other . If you choose “Other”, you can perform file and directory
operations but with certain limitations. Please note that the selection of the correct
system type is very important for parsing the file list into directories and files, as the
file and directory representation differs for different Operating Systems. FTP is able
to recognize the remote side system to a limited extent, but a wrong selection may
display a strange directory structure.

Select "Connect" when you have entered all parameters. FTP will try to connect to
the remote system. On successful connection all the windows in the bottom region
(remote side) will be filled with the relevant details.

The Host  drop down box of the remote region displays a list of previously accessed
hosts. The currently selected host is the one you are connected to. You can also
change your connection by selecting another host name from this drop down list box.
You are prompted to confirm the disconnection from the current host. Select "Yes" to
connect to the next host. If you want to re-establish your connection with the same
host just double click on this box.

Disconnecting from remote system

While you are connected to an FTP server, the Connect  menu changes to
Disconnect . The toolbar button also changes to a connected one. You can either
click on this button or select the Disconnect  menu to close your connection with the
host.

3.15.4 Using FTP

Once the connection is established, the file transfer buttons on the toolbar are
enabled. You can now execute any of the commands that are available to you. All of
these commands are explained in this section.
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F Note:  If the currently selected region is Local,  then commands like rename files,
delete files, change directory etc. would be performed on local files and if the
selected region is Remote  these commands would be performed on remote
side. Just make sure that you have selected the correct region before using
these commands.

3.15.4.1 Selecting files

Select local region if you want to send files and remote if you want to receive files.
First move to the directory from which you want to transfer files. The drive on local
side can be changed by Drive drop down box. You can also use the Change
directory option to move to a specific directory.

For selecting a single file just select that file from the list box or type in the name in
the text boxes provided in both regions.

For selecting multiple files press the "SHIFT" or "CONTROL" key and use mouse
click to select files. You can also use the "UP" or "DOWN" keys from the keyboard in
place of mouse. Please note that since the mouse is being used for Drag and Drop,
you would not be able to select files by dragging the mouse in the file list box. As you
keep on selecting files, the status bar will show the number of files selected and the
total size of all the files.

You can move around FTP using the TAB key, although the mouse is recommended.
Pressing TAB key will move the selection to the next window of the same or different
region. The Hot key "ALT S" can be used to select the Host dropdown box of remote
region and "ALT R" to select the Drive dropdown box.

Drag and Drop

The AlphaLAN FTP supports drag and drop interface for transferring files from one
region to other. For multiple file selection and drag and drop, you need to keep the
mouse button pressed while tagging the last file you want to transfer. The cursor
changes to a document cursor, if you are in a valid area for a drop, else it changes to
an invalid cursor. Please note that when selecting multiple files, remember not
to release the mouse button if you want to drag and drop the selected files,
since doing this would change your selection.

Selecting an entire directory

To transfer all the files from a directory click on the directory name and keeping the
mouse button pressed, drag the folder shaped cursor to the destination side. You
can also drop on the directory list box to transfer files in the particular sub-directory
of the current directory.

Selecting files for an unrecognized system

In case the remote system is not recognized by AlphaLAN FTP, the file list box will
only show the file listing received from the remote. The directory list box will remain
empty. In this case the sizes are not shown along with names. However, to view the
complete listing you can still use the information box, explained later in this section.

Selecting multiple files from different sub-directories
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FTP provides a unique feature of selecting multiple files from different sub-directories
of local or remote side. For this select file(s) from one directory and then keeping the
CONTROL key pressed change the directory, and select more files. This way
keeping the CONTROL key pressed you can select files from different sub-
directories. The status bar will show a count of the currently selected files.

3.15.4.2 Receiving / Sending Files or Directory

Select the files, to be sent / received using the above mentioned methods. If using
drag and drop, drop the selected files on the local / remote side file or directory list
box. Dropping on a particular directory name in the directory list box will receive the
files in that directory. If the drop is on the directory list box but not on any directory
name, then the files will be received in the current directory (the one which is opened
on local side). You can use the "Receive" menu item of "File" menu to receive the
selected files and "Send" to send the selected files. The toolbar buttons for send and
receive can also be used. Double clicking on a file in the file list box, will also start
the send / receive session of that file.

Before starting transfer, just make sure that you have selected the proper mode
ASCII or BINARY from the Settings dialog box of "Options" menu. The confirmations
for overwrite etc. should also be ON, if needed. Moreover, check that append option
is OFF if you do not want to append files to the existing files.

If the confirmation for “File copy” is ON, before starting the transfer a dialog box
shown below will appear asking for the confirmation.

You can specify a different destination file name in this dialog box.

When the file transfer, is in progress, a dialog box appears on the screen showing
the current status of transfer. The display shows the progress for the current file
being transferred and the progress for the total file transfer (useful for multiple file
transfer) in two progress bars. A display of number of files to be transferred and the
number of files already transferred are also displayed. The total time passed and the
time remaining is also shown.
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While transfer is in progress, most command buttons are disabled (grayed). You can
still perform informative operations, such as viewing directory and file information,
and checking help. On completion of transfer a message is displayed on the status
bar showing the information like total files transferred, success and failure, speed of
transfer etc.. The same information you can get from the "Transfer Status" item of
"Options" menu.

The name of the receiving file is truncated if the original file name has a primary
name longer than eight characters and extension longer than three characters. Also,
if the file name on the remote side contains any characters which are not valid for the
local side, all such offending characters are removed from the file name.

Aborting file transfer

The file transfer can be aborted in between by pressing the "Abort" button from the
dialog box showing the status of transfer. However, the abort of receiving file will
depend upon whether the remote system supports "ABOR" command or not. If the
remote system does not support abort command then the current file will be received
completely, even if you press "Abort" button.

Auto Sensing of Binary mode

If you try to transfer a binary file in ASCII mode, a message box will appear, asking
for the continuation of transfer. You can either continue the transfer or abort it. You
can reset this option from the "Settings" dialog box.

3.15.4.3 Renaming Files or Directory

You can rename the currently selected file or directory on your local or remote
system. For renaming files select one or more files from the file list box, and select
the rename button on the toolbar or select "Rename" from the "File" menu. For
renaming directory, select the directory to be renamed from the directory list box of
remote or local side.

A dialog box appears prompting for new name. Enter the new name and select
"Rename". If you want to skip the renaming of current file select "No", and select
"Cancel" if you want to cancel the renaming of all the remaining files.

3.15.4.4 Deleting Files or Directory

You can delete one or more files from any local or remote directory. You can also
remove an empty directory. For deleting files, select the files from file list box of local
or remote side, and then select the delete button of toolbar or select the "Delete" item
from the "File" menu. Similarly, select the directory to be removed and then select
the remove button from toolbar or select "Remove" item from the "Directory" menu.
You can press the "DELETE" key from the keyboard to perform the delete operation.

It is advisable to have the confirmation of delete always ON. This would avoid the
inadvertent deletion of files. This confirmation can be made ON from the Settings
dialog box of "Options" menu.

3.15.4.5 Information about files

You can get the information about the selected files or all files of a directory from the
"Information" item of "File" menu. The information of the selected file in the current
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region will be shown in a dialog box. If no file is selected the complete file listing of
the current directory will be shown.

The detailed information like file size, creation time, attributes etc. would be shown in
this dialog box. This dialog box can be kept on the screen for further reference. The
same dialog box will show the information about both local and remote files.

You can view the contents of a local text file, by double clicking the right mouse
button on it in the file list box of FTP window. This will open the file in the Notepad for
editing.

3.15.4.6 Creating Directories

New directory can be created on both local and remote systems. To create a
directory, first move to the directory in which you want to create this new directory.
Then select the "Create" item of "Directory" menu or click on the corresponding
button in the toolbar. You can enter any name valid for the system.

3.15.4.7 Changing Directories

You can move to any path by using the "Change" menu item of "Directory" menu.
This helps you to switch to a specified path without using the directory tree,
particularly for an unrecognized remote system for which the directory tree is not
shown.

3.15.4.8 Updating Directories

The "Update" menu item of "Directory" menu updates the directory structure of both
local as well as remote side. This option can be used to get the latest directory
information of remote side, particularly when a number of users are accessing the
same host.

F Note:  The execution of all the above mentioned commands like renaming,
deleting etc. would depend upon the access permission of the client and if that
command is supported by server or not.

3.15.5 Options

AlphaLAN FTP allows you to set certain options useful for file transfer. These options
are explained in this section.
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3.15.5.1 Data Logging

Data logging can be started by selecting "Start Log" option of "Options" menu.
Selecting this option would start the logging in the "LOG.TXT" file in the current
directory on local side. Logging allows you to record the File Transfer Protocol
messages exchanged between the client and the server. The log file is very useful
for debugging, tracing interoperability issues, and the like. It is not intended as a tool
for the desk user, but rather, it is intended to be used by a networking professional.

It is advisable to make the logging ON while transferring a large no. of files. This
would help you in finding out the reasons of file transfer failures.

You can stop the logging by selecting the option "Stop Log" from the "Options" menu.

3.15.5.2 Settings

A dialog box appears on the screen when you select "Settings" option from "Options"
menu. This allows you to select the mode of transfer as ASCII or Binary . Before
transferring files you should make sure that binary transfer is ON, for binary files.
Transferring a binary file in ASCII transfer mode would lead to the data corruption.
You can set the option "Auto Sensing of Binary mode" to detect any binary file being
transfer in ASCII mode.

You can select the "Append" option if you want to append the data to the existing file.
If the file doesn't exist on the destination side, a new file will be created. By default
the "Copy" option is ON which will overwrite the existing file or create a new file.

The "Use ALLO command" can be set if you want to send an ALLO command before
sending the APPE or STOR command. The ALLO is the standard FTP command
used by some servers to reserve sufficient storage to accommodate the new file to
be transferred. For AMOS the ALLO command is used to store the next file as
random file .

Along with this, you are asked for some confirmations. The "Directory remove" option
will confirm the deletion of directory and the "File Delete" will confirm before deleting
any files. The "File Overwrite" and "File Append" options will ask before overwriting
and appending to an existing file. The “File Copy” option will confirm for destination
file name before starting transfer. It is strongly suggested that you leave these
confirmations ON to avoid any accidental loss of files.

The remote directory update options allow you to stop updating of remote side
directory after every transfer and after every connect. This would be useful when
connecting to a system with large number of files.

The macro file option allows you to set the execution of a macro file on start of FTP.
When this option is set the FTP will execute the macro file whose name is written in
FTP.INI file. This name can be set from the file selection dialog box that appears on
the screen when you select "Run" option from "Macro" menu. If you want to stop the
execution of FTP, once the macro file execution is over, select the button "Exit FTP
after macro execution".

3.15.5.3 Transfer Status

The "Transfer Status" option allows you to get the information about the last transfer
you performed. This option is very useful if you want to transfer a large number of
files. After the transfer, this option will give you an update of all the files which were
transferred successfully, all those files which were skipped along with those files
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which were not transferred due to some errors. This also gives you some statistics
like the total bytes transferred, total time taken and the speed of transfer.

3.15.6 Command Line

In addition to the Drag and Drop interface the FTP provides a command line
interface. The following dialog box will appear when you select "Command Line"
option from "File" menu.

The combo box will show a list of valid commands, you can select any command
from that. After writing the required arguments you can send that command by either
selecting the "Send" button or pressing the "ENTER" key. The commands that you
have entered will appear in the list box below.

If the Debug mode is ON, the actual FTP commands sent to remote machine would
be added in the list box. The replies received from the remote in response to
individual commands would also be added, if the Verbose mode is ON. Setting the
"Beep after file transfer" option will cause a beep to sound after each file transfer
command is completed. "Prompt on multiple commands" option is used for
interactive prompting. Interactive prompting occurs during multiple file transfers to
allow the user to retrieve or store files selectively. If prompting is turned OFF (default
is ON), any mget  or mput  will transfer all files, and any mdelete  will delete all files.

The "Clear" button will clear the list box and the "Select" button will make the
selected entry of list box to appear in the command box.
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The following is the list of all those commands recognized by FTP. Commands may
be abbreviated.

account <account> send account command to remote server
append <local file> <remote file> append to a file
ascii set ascii transfer type
binary set binary transfer type
bye terminate FTP session
cd <remote directory> change remote working directory
cdup change remote working directory to parent 

directory
close terminate FTP session
delete <remote file> delete remote file
dir <remote directory> list contents of remote directory
disconnect terminate FTP session
form set file transfer format
get <remote file> <local file> receive file
help <command> shows the one line help of command
idle get (set) idle timer on remote side
image set binary transfer type
lcd <local directory> change local working directory
ls <remote directory> list contents of remote directory
mdelete <remote files> delete multiple files
mdir <remote files> list contents of multiple remote directories
mget <remote files> get multiple files
mkdir <directory name> make directory on the remote machine
mls <remote files> list contents of multiple remote directories
mode set file transfer mode
mput <local files> send multiple files
nlist <remote directory> nlist contents of remote directory
open <host> connect to remote host
put <local file> <remote file> send one file
pwd print working directory on remote machine
quit terminate FTP session
quote <command> send arbitrary FTP command
recv <remote file> <local file> receive file
reget <remote file> <local file> get file restarting at end of local file
rstatus show status of remote machine
rhelp get help from remote server
rename <old name> <new name> rename file
rmdir <directory> remove directory on the remote machine
send <local file> <remote file> send one file
site send site specific command to remote server
struct set file transfer structure
system show remote system type
user <user name> <password> send new user information
The command line interface provides the send, receive and deletion of multiple files
using wild cards. The dir listing of selected files can also be viewed using the dir  or
nlist  commands. Some of the FTP commands which are not available otherwise are
also provided in command line interface.

3.15.6.1 Macro file

The "Macro" menu options allows you to automate file transfer by making macro
files. The "Record" option will prompt for a file name and will start recording (writing)
of FTP commands in the specified file. The commands that would be written are
those listed above in the section "command line". The "Stop" option will stop the
recording. You can create a macro file by using the record mode and performing the
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simple drag and drop operations to transfer the files. Later on you can edit this file to
change it accordingly.

The "Edit" option will ask for the macro file name and will open the file in Notepad for
editing.

On selecting the "Run" option, a file selection dialog box would appear asking for the
name of file to execute. In this dialog box you can also set the option "Set for
Autostartup" to make the file run automatically on starting of FTP. The specified
macro file would be executed by sending the each FTP command written in the file.
The errors encountered would be stored in the ERROR.LOG file.

3.15.7 Initialization file

All those options set by you are saved in the FTP.INI file along with the hosts list.
You can edit this file with any editor, although it is not recommended.

3.15.8 Getting Help on FTP

The "Help" menu will provide the on line help. This menu also shows the about box
which gives the version information about AlphaLAN FTP. A button is provided in
toolbar to get the context sensitive help.

3.16 Other Miscellaneous functions

3.16.1 Changing Directory

This option can be used to change the working directory as well as the file transfer
upload/download directories on your PC. If the “Directories...” option is selected from
the “File” menu bar, a dialog box would pop up and the Current Working Directory
and the file transfer upload/download directories would be shown. You can select
these directories as per your choice. By default, UPLOAD and DNLOAD sub-
directories in the AlphaLAN directory would be used for file transfers.

3.16.2 Menu hide and lock

An option, “Lock Menu” is added in three menu bar items: “File”, “Settings” and
“Preferences”. These menu bar items can be locked by checking the “Lock Menu”
option provided in their respective submenus. Once a menu item is locked, all the
options in that menu item will become inaccessible to the users. You may lock the
required menu option to prevent change of settings accidently. Once locked, the
menu item can not be unlocked from any menu bar or toolbar option. You can
unlock the menu item only by editing the corresponding configuration (.INI)
file .

The three parameters associated with locking/unlocking of menu items in the
configuration file are LOCKFILE, LOCKSETTINGS and LOCKPREF. To unlock the
menu item, edit the .INI file and change the above parameter values from TRUE to
FALSE and restart the application.

3.16.3 42/49 row support in WYCOL emulation

You can now have 42 or 49 rows in the WYCOL emulation. So, the host applications
can take advantage of this new feature and can display more lines on the screen.
The following escape sequences may be used to switch to the desired mode:
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24 rows (Normal) : Esc c (
42 rows : Esc c *
49 rows : Esc c 1

3.16.4 Full-screen window

If you select the “Full Screen” option from the “View”, the menu bar, tool bar, status
bar, etc. will all disappear and the Terminal Window would occupy the full screen. To
get back to the standard Window, double click the mouse or press “Shift” and “Esc”
keys simultaneously. You can also click on the “Full Screen” icon in the tool bar to
switch to full screen mode.

3.16.5 Special purpose Escape sequences

You may use escape sequences to perform functions like data logging and invoking
your customized “.UDK” file.

By giving the escape sequences, you can play a log file which may contain Escape
codes to paint your screen. This will make painting of screens very fast especially at
lower baud rates.

You can also load a “.UDK” file by sending the corresponding sequence. This can be
used by AMOS programs to display different user defined keys for different screens.

The corresponding escape sequences are:

Data Logging :

Start : Esc~+2<filename>;
Stop : Esc~+3

Replay : Esc~+0<filename>;

Invoking “.UDK” file :

Load UDK file : Esc~+1<filename>;

3.16.6 3-D controls

All dialog boxes of Winorbit now have a new 3-Dimensional look.

3.16.7 Replay host log file

Replay host log file. If you select the “Replay...” option from the “Data Logging”
submenu of the “File” menu item, the captured log file would be replayed locally on
your PC. You do not have to transfer the host log file on to the host system and type
it.

3.16.8 On-line help for dialog boxes

You can get help on the opened dialog box by pressing F1.

4. List of changes/improvements/modifications
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Changes/Improvements New/Changed
files (PC side).

1. File transfer over various modem file transfer protocols. WINORBIT.EXE, MODEM.DLL, ORBIT.EXE,
SETPC.EXE, XFER.EXE.

2. Improved speed of Field Emulation in AlphaLAN/FW
(Fast Field Emulation).

WINORBIT.EXE.

3. Improved PhoneBook for DOS (PB.EXE) to work with
Modem file transfer program, XFER.EXE

PB.EXE

4. Added AM62C and PCFM emulation. WINORBIT.EXE

5. Tool Bar. WINORBIT.EXE, TOOLBAR.DLL.

7. Improved UD keys. WINORBIT.EXE.

8. PicLan protocol support. WINORBIT.EXE.

9. Selectable foreground color on AM70/WYCOL
emulation.

WINORBIT.EXE. ORBIT.EXE.

10. Shut off printing. WINORBIT.EXE, ORBIT.EXE, SETPC.EXE

11. Editable Save/Restore pages. WINORBIT.EXE

12. Upload/Download directory. WINORBIT.EXE, MODEM.DLL,
INSTALL.EXE

13. Status line help. WINORBIT.EXE

14. UA fonts to ANSI fonts. WINORBIT.EXE

15. Improved installation programs. INSTALL.EXE (Windows), ALINSTAL.EXE
(DOS)

16. Improved modem command handling. MODEM.DLL, WINORBIT.EXE

17. Improved Menu bar and Toolbar. WINORBIT.EXE, TOOLBAR.DLL

18. Confirm if loading a new .INI file. WINORBIT.INI

19. Column selection from “right mouse” to “Alt Left mouse
button”.

WINORBIT.EXE

20. Warn if loading another session on the same
serial/modem port.

WINORBIT.EXE

21. Auto startup in Z-Modem file receive. WINORBIT.EXE

22. Launch AlphaLAN in minimised state. WINORBIT.EXE

23. Menu locking. WINORBIT.EXE

24. Improved TELNET/Rlogin support. WINORBIT.EXE

25. Improved TCP/IP connect box. WINORBIT.EXE

26. Improved Fast Field Emulation. WINORBIT.EXE

27. 42/49 row in WYCOL WINORBIT.EXE, ORBIT.EXE

28. Get input from Secondary port and pass it on to the host
(Bi-directional mode).

WINORBIT.EXE

29. Replay captured host log file. WINORBIT.EXE

30. Border Patterns. WINORBIT.EXE
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31. On line help from Dialog box. WINORBIT.EXE.

32. Full screen Window. WINORBIT.EXE

33. Improved DOS setup program with modem menu setup
options and confirmation on exit.

SETPC.EXE

34. FRCTRM to return DOS ERRORLEVEL. ORBIT.EXE, FRCTRM.COM

35. Destination filename support in NATIVE file transfer
(CPC/CALF).

WINORBIT.EXE, ORBIT.EXE,
CPC.LIT, CALF.LIT (AMOS side)

36. Larger than 32 MB files transfer in Native mode (CALF). WINORBIT.EXE, ORBIT.EXE.
CALF.LIT (AMOS side)

37. Improved cursor positioning TCRT calls handling. ORBIT.EXE

38. Improved spawned job handling in open comm. mode
(problems with MULTI).

ORBIT.EXE, CTRM.COM

39. Improved error handling by CTRM. CTRM.COM

40. Improved switching to open comm. mode. OPEN.EXE

41. Improved security handling in open comm. mode. ORBIT.EXE, PCRST.COM

42. Robust file transfers in Native mode. ORBIT.EXE, CPC.LIT, CALF.LIT

43. Keyboard Remapper. SELORB.DLL, WINORBIT.EXE

44. Bi-directional support in WYSE50 emulation (Windows
only).

WINORBIT.EXE

45. Modified terminal emulation (erase to end-of-line, split
screen/cursor positioning, box fill with attribute, top
status line (Windows only)).

WINORBIT.EXE

46. Graph in Windows. SELORB.DLL, WINORBIT.EXE

47. FTP over TCP/IP. FTP.EXE

48. FINGER over TCP/IP. FINGER.EXE

49. 3-D controls. WINORBIT.EXE, CNTORB.DLL

Disclaimer

The information in this document could include inaccuracies or typographical errors. U.A. Systems, Inc. makes no
representation or warranties with respect to the contents of this document and specifically disclaims any implied
warranties of merchantability or fitness for any particular purpose. Further, U.A. Systems, Inc. reserves the right
to make changes from time to time without obligation of U.A. Systems, Inc. to notify any person or organization of
such changes.
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U.A. Systems, Inc.

P.O.Box 9214
Fountain Valley CA 92728

Voice: (714)708-2171
   Fax: (714)708-2172

E-mail: umesh@netcom.com



Appendix A

Windows for Workgroups 3.11 and AlphaNET

To install AlphaNET in a Windows for Workgroups network, you will need to make
sure that Windows for Workgroups is up and running using “MICROSOFT
WINDOWS NETWORK” over a NDIS2/NDIS3 compatible Ethernet card. If this is not
installed, you can do so by starting Windows for Workgroups and opening “Network”
group. Click on “Network Setup” icon, then on: “Network” and finally on “INSTALL
MICROSOFT WINDOWS NETWORK”. Now follow the installation instructions
provided by your card manufacturer to install the Ethernet card.

Make changes to the following files, if necessary:

CONFIG.SYS

If you had installed AlphaNET for NDIS previously, you may have entries in the
config.sys for files like -protman.dos, an NIC driver, and dis_pkt.dos. Since
WFW3.11 loads these devices from the SYSTEM.INI file, comment out the
aforementioned device statements if they are present. Some of these programs
could have been loaded from AUTOEXEC.BAT file or any other BAT file called from
AUTOEXEC.BAT. Please comment out all such references.

Check that the following entry is present in this file. If not add it:

DEVICE=C:\WINDOWS\IFSHLP.SYS

AUTOEXEC.BAT

Check that the following entry is present in this file. If not add it:

C:\WINDOWS\net start

PROTOCOL.INI

Once your Windows for Workgroups network is running, add the [PKTDRV]  section
shown below to your PROTOCOL.INI. The following is a sample for an Compex
ENET card. You would replace “MS$ENET” with the name of the network adapter
driver name defined in the netcard=  entry in the [network.setup]  section.

[PKTDRV]
BINDINGS=MS$ENET
INTVEC=0X66
DRIVERNAME=PKTDRV$

The 0X66 is the interrupt number used by the packet driver.
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SYSTEM.INI

In the transport=  entry under the [network drivers]  section add an entry for
dis_pkt.dos or dis_pkt.gup. Do not delete any existing entry, just add this at the
end of the transport=  line. Also under the same section check that the
LoadRMDrivers=  entry is set to “Yes”. An example entry for these two entries under
the [network drivers]  section would be:

transport=ndishlp.sys,*netbeui,c:\alphanet\dis_pkt.dos
LoadRMDrivers=Yes

where the entry “c:\alphanet\dis_pkt.dos” is the additional change done to the
existing transport=  entry. The dis_pkt.dos or dis_pkt.gup files are provided as part
of your AlphaNET software.



Appendix B

WINSOCK compliant TCP/IP stacks supported by AlphaLAN 6.0

AlphaLAN 6.0 has been tested on the following TCP/IP stacks :

· Distinct TCP/IP
· Lan WorkPlace
· Microsoft TCP/IP 16-bit - Works with Windows for Workgroups 3.11
· *Microsoft TCP/IP 32-bit (Wolverine) - Works with Windows for Workgroups 3.11
· PC/TCP OnNet 1.1
· PC/TCP Network Software 3.0 for DOS and Windows
· PC/TCP Network Software 2.x
· Trumpet
· WRQ Reflection 2

* AlphaLAN FTP has some limitations when used over Microsoft TCP/IP 32 bit stack.

This information is constantly being updated. If your TCP/IP stack is not present in
the above list, call your local dealer or U.A. Systems to get additional information.


